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1.7.2 M. Fichaut, S. 
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1.7.3 S. Crouzille 19/01/2022 Update: Version number 
1.7.4 S. Crouzille, M. 

Fichaut 
22/06/2022 Update: version number 
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 For CSV files: Auto-fill of the parameter table 
(§7.4.2.5) 

 For CSV files: Auto-fill of the start and end position 
in the parameter table for the measured 
parameter (§7.4.2.4.7) and the corresponding 
flags (§7.4.4.2) 

The CDI summary file for MIKADO has been enriched to 
provide more metadata (§7.5.4) and a track is now 
generated for trajectory files (§7.5.4.3) as well as a list of 
projects (EDMERP) linked to a cruise (§7.5.4.2. 

A new BatchBuilder tool helps to create .bat or .sh batch 
command files (§7.8.4) 

The NEMO parser has been rewritten to separate clearly the 
management of CSV files and Text files without separators 
(§7.3 introduction and §7.4.1.1) 
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1. Introduction 
For purposes of standardisation and international exchange, SeaDataNet has defined common formats 
[1] for data exchange and distribution which are: 

 ASCII SeaDataNet ODV [1] (Ocean Data View) format is a version of the ODV version 4 generic 
spreadsheet format modified to carry additional information required by SeaDataNet. Variants 
of this SeaDataNet ODV format have also been defined for Biological [4] [5], flow cytometry 
[8] [9], and microlitter data [6] [7]. 

 MEDATLAS [1] [2] which is an auto-descriptive ASCII format designed in 1994, by the 
MEDATLAS and MODB consortia, in the frame of the European MAST II program in conformity 
with international ICES/IOC GETADE recommendations. As for ODV, the format has been 
upgraded to carry additional SeaDataNet information, 

 SeaDataNet netCDF format [1] which is an auto-descriptive binary format  

netCDF and ODV formats are both mandatory in SeaDataNet while MEDATLAS is optional. 

All these formats are described on the SeaDataNet website, and examples are provided for each format 
type (https://www.seadatanet.org/Standards/Data-Transport-Formats). 

NEMO is a reformatting tool able to reformat any ASCII files (input file) of vertical profiles, time-series, 
and trajectories to a SeaDataNet ASCII format (output file at ODV or MEDATLAS format) and 
SeaDataNet netCDF format.  

1.1. Main principles  
The input files of NEMO can be individual vertical profiles, time series or trajectories, or files grouping 
several vertical profiles, time-series, or trajectories of the same data type (CTD, bottle cast, current 
meter, thermosalinograph…). All these entities (vertical profile, time-series, and trajectory) are called 
stations in NEMO software. 

NEMO can reformat: 

 a single file or  

 a group of files in one directory or  

 a group of directories containing several files.  

The only requirement is that the input files of NEMO are ASCII, with data measurements in columns. 

As the entry file can be in all kinds of ASCII formats, NEMO must be able to read all these formats to 
translate them to ODV, MEDATLAS, or netCDF. 

To do so, the principle is that the user of NEMO describes the input file formats so that NEMO can find 
the information, which is necessary to generate the files at SeaDataNet formats. 

One very important pre-requirement is that in a set of input files, the information about the stations 
must be located at the same position: same line in the file, same position on the line, or same column 
if Comma Separated Value (CSV) format. Furthermore, station information must be in the same format 
in all the stations.  

For example: for all the stations, the latitude is on line 3 on the station header, from character 21 to 
character 27(or in the 4th column in CSV format), and its format is decimal degrees (+DD.ddd). 
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1.2. NEMO and MIKADO interactions  
NEMO was designed to be linked to the SeaDataNet tool ‘MIKADO’ [3] through the generation of a text 
file that can be converted to Excel. 

The principle (Figure 1) is that while NEMO converts one file or a collection of files (like for example a 
collection of XBT files in a specific geographical area), it also generates a “ CDI summary CSV file” which 
contains all the minimum information necessary to create CDI records in the SeaDataNet catalogue.  
This CSV file can be read by MIKADO (automatic generation) using a JDBC driver and then XML CDI files 
are generated (using predefined queries delivered with MIKADO) and can be directly exported to the 
central SeaDataNet catalogue. 

 

Figure 1– From « raw » data files to SeaDataNet CDI catalogue 

1.3. Technical characteristics 
NEMO is a portable software that can be downloaded from the SeaDataNet website 
https://www.seadatanet.org, free of charge, with its user manual.  

It is written in Java Language (Version >= 1.8) and it is available under Microsoft (tested with Windows 
10)  It is also available for Linux and Unix but not tested in IFREMER. 

NEMO works offline; however, as it uses the SeaDataNet common vocabularies web services to update 
its lists of values, a network connection is needed only when an update of these lists is necessary. 

 To know if Java is available on your computer, in the right version, follow these steps:  

 Open the ‘Start’ menu, then ‘Execute’  

 On the displayed window, enter: ‘cmd’, then click on the ‘OK’ button 

 Enter ‘java -version’  

 Check if the command has been executed:  

 If not, download the last java version at http://java.com/en/download/index.jsp.  

 Else, check the version displayed. The version should be greater than or equal to 1.6.  
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Figure 2 – Check the Java version installed on your computer 

2. FAQ 
The Frequently Asked Questions about Nemo software are available online and are regularly updated:  

https://www.seadatanet.org/Standards-Software/Software/NEMO/FAQ  

If you do not find the answer you need in this FAQ, do not hesitate to contact our helpdesk at sdn-
userdesk@seadatanet.org 

3. NEMO installation and uninstallation 

3.1. NEMO installation 

3.1.1. Installation for Windows 

Get NEMO software from the SeaDataNet Web site, under Standards & Software: 

https://www.seadatanet.org/standards_software/software/nemo 

Copy the zip file on your computer, and unzip it. 

You will get 2 files: install_nemo.jar and launcher.bat 

If Java is not installed on your computer (see chapter 1.3), install it. 

To install NEMO double click on the file launcher.bat. 

Then select your language and run the installation. 

1. Accept the terms of the license agreement. 

2. Select the installation path (default is C:\ Program Files\NEMO) 

 target directory is created if it doesn’t exist. 

 if the target directory exists, you will have to confirm overwriting 

Even if you choose to overwrite an existing directory, you will be able to keep your preferences 
from Nemo’s last installation 
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3. After the Pre-installation script click on the “Next” button 

4. Confirm the installation path and click on the “Next” button 

 if you overwrite an existing directory, you will be asked 5 times to overwrite particular files: 

o NemoConfiguration.xml 

o nemo.ini 

o userParametersLabels.xml 

o userParametersStandardNames.xml 

o userParametersnetCDFLongNames.xml: 

 

These 5 files contain your Nemo Settings and your labels (§7.4.2.4-Fulfill parameter values and 
test). 

For each of these 5 files, click “NO” to keep your preferences. 

5. If you want a shortcut on your Desktop check the box circled in red on the image below. You can 
create a shortcut for the current user or for all users of the computer (circled in blue); by default 
“all users” is checked. 

 

Figure 3 – Installation of NEMO – definition of shortcuts. 
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The shortcuts are created on the desktop and in the Start menu of the computer with the following 
icon:  

on the desktop or  in the start menu under the group defined in the 
circled green field in Figure 3. 

 

Figure 4 – Last screen of NEMO installation 

If NEMO needs to be installed on several computers, it is possible to “Generate an automatic 
installation script”, by clicking on the appropriate button on the last screen of NEMO installation 
(Figure 4). 

3.1.2. Installation for Linux 

Get NEMO software from the SeaDataNet Web site, under Standards & Software: 

https://www.seadatanet.org/standards_software/software/nemo 

1. Copy the Linux, Linux64bits zip file on your computer, and unzip it (tar -xzf file.tar.gz). 

2. You will get 2 files: install_nemo.jar and launcher_nemo.sh 

3. If Java is not installed on your computer (see chapter 1.3), install it. 

4. To install NEMO, run launcher_nemo.sh or type java –jar install_nemo.jar. See paragraph 3.1.1 to 
proceed to the installation. 

5. To run NEMO, run ./launcher_nemo.sh 

3.2. NEMO uninstallation 

3.2.1. Uninstallation for Windows 

If you want to remove NEMO from your computer, run the uninstaller by selecting NEMO Uninstaller 
in the start menu of your computer (see paragraph 3.1). 
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If running the uninstaller generates the following message: 

 

please run C:\NEMO_Installation_directory\Uninstaller\launcher_uninstaller.bat (or 
unsinstall_nemo.sh for Linux). 

The following window opens: 

I  

Click on Force the deletion of C:\NEMO_Installation_directory 

And then click on Uninstall. 

3.2.2. Uninstallation for Linux 

If you want to remove NEMO from your computer, run the uninstaller by using the following command 
in the Uninstaller directory: 

./uninstall_nemo.sh 

4. Controlled vocabularies 
NEMO includes functionalities to import SeaDataNet controlled vocabularies, EDMO (European 
Directory of Marine Organisations) catalogue, EDMERP (European Directory of Marine Environmental 
Research Projects), and some information from IFREMER database useful for MEDATLAS format (such 
as a subset of Roscop codes corresponding to sensors available on NERC/BODC vocabulary or format 
and default values for MEDATLAS parameters).  

SeaDataNet-controlled vocabularies used by NEMO are available at the following address: 
http://seadatanet.maris2.nl/v_bodc_vocab_v2/welcome.asp 

NEMO uses the following lists: 
List code List Name 

C16 SeaDataNet Sea Areas 

C17 ICES Platform Codes 

C18 IOC country codes 

C19  SeaVoX salt and fresh water body gazetteer 
 

C77 SeaDataNet Cruise Summary Report data categories 

mailto:sdn-userdesk@seadatanet.org
http://www.seadatanet.org/
http://seadatanet.maris2.nl/v_bodc_vocab_v2/welcome.asp


 

sdn-userdesk@seadatanet.org – www.seadatanet.org 

SeaDataNet - The pan-European infrastructure for marine and ocean data management 

 15 

L05 SeaDataNet device categories 

L06 SeaVoX Platform Categories 

L07 SeaDataNet data access mechanisms 

L08 SeaDataNet Data Access Restriction Policies 

L20 SeaDataNet measurand qualifier flags 

L22 SeaVox Device Catalogue 

L23 SeaDataNet Metadata entities 

L30 MEDATLAS Data Centres 

L33 WMO C3 vocabulary of XBT data types 

P01 BODC Parameter Usage Vocabulary 

P02 BODC Parameter Discovery Vocabulary 

P06 BODC data storage units 

P07 Climate and Forecast Standard Names 

P09 MEDATLAS Parameter Usage Vocabulary 

C16-C19 Mapping between C16 and C19 

L05-C77 Mapping between L05 and C77 

P01-P02 Mapping between P01 and P02 

P01-P09 Mapping between P01 and P09 

P02-P09 Mapping between P02 and P09 for CDI summary 

P06-P01 Mapping between P06 and P01 

P06-P09 Mapping between P06 and P09 

P07-P02 Mapping between P07 and P02 

EDMO European Directory of Marine Organizations 

EDMERP European Directory of Marine Environmental Research Projects 

CSR CSR list for mapping between LOCAL_ID un central ID of the CSR 

Parameters Idem than P09 with the default value and format information 

Surveys Use by IFREMER for server initialisation on the Cruise step 

 

When running NEMO, the controlled vocabularies can be downloaded when using the menu “Options” 
and “Vocabulary update”. 

A window shows the progression of the update, where you can see the name of the list which is 
updated, and its rank among the total list to be updated: 

 
 

While updating is running, it is possible to stop it by pressing the “Cancel” button; NEMO tells which 
lists have been updated and where the update was interrupted. 
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At the end of the updating process, a summary is displayed: 
 

   
 

For the lists which have a version number, NEMO tests if the present version number of a given list has 
changed since the last update of NEMO vocabulary lists. If no, “no need to update” is mentioned in the 
summary. 

In the Web services info window, if FAILED is mentioned in front of a category of a list (CSR, NEMO, 
BODC lists, Mapping EDMO, or EDMERP), it means that: 

 NEMO is not able to connect to BODC, Maris, or Ifremer  web services  or 

 no internet connection available on your PC at that moment or 

 the firewall of your organization prevents such connection (please contact your network and 
security team) or 

 the connection for your PC to the internet is not direct but is established through a proxy (in 
that case see §9).  
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5. Common functionalities 

5.1. Global description of NEMO’s main screen 
NEMO’s main screen is divided into 3 parts that are described in the sections below.  

 

Figure 5 - NEMO  main screen 

5.1.1. Left part of the NEMO Screen 

In this left part are the different tabs of NEMO, used to describe the input file(s) (see chapter 7). It is 
divided into 2 sub-parts, the upper one is used to display the input file, and the lower one is used to 
input some information about the file. 

The input file is displayed on the 4 first tabs on NEMO so that the user can visualize and directly select 
information in the input file (see chapter 5.2). 

5.1.2. Right part of the NEMO screen 

The right part is used to describe metadata in the input file. It is also on this part that the user can 
validate or reset each step of the description. 
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5.1.3. Bottom banner of NEMO screen 

5.1.3.1. Tab “Log” 

This tab gives information about the validation of a step in NEMO or about the data conversion in the 
last step of NEMO. 

If the information is an error, it is written in red, if not it is written in green. 

 

Figure 6 – Example of an error message 

 

 

Figure 7 - Example of an informative message 

5.1.3.2. Tab “Info” 

This tab gives information on the input file or the input directory, and also on the used model if a model 
has been loaded. 

 

Figure 8 - Example of  content of the Info tab  

5.2. Set “Button” 
One principle of NEMO for the description of the input file(s) is to select the information in the left part 
of the screen (where the input file is displayed) and then press the “set” button: 

 to input the number of selected lines or 
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 to input the selected text  or 

 to input the position on the information (number of the line in the file, and the start and end 
character on the line). 

Example: 

Number of lines in the station header: The lines of the station header are selected on the left side of 
the screen (circled in blue), then when pressing the set button, the number of lines is set in the field 
(circled in red). 

 

 

Text in Indicator of end of data: The text which indicates the END of data is selected on the left side of 
the screen (circled in blue), then when pressing the set button, the text is set in the field (circled in red). 

 

Position of the latitude in the station header: The latitude value is selected in the left side of the screen 
(circled in blue), then when pressing the set button, the line and the start and end characters are set in 
the fields (circled in red). 
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5.3. The “Test” button 
This button is used to verify that the input information is correct. It works for manual and automatic 
input. 

In the example below, the user uses automatic input, he tells NEMO to read the latitude on line 13 of 
each station header from character 14 to character 22 at format NDD MM.mm. Clicking on “Test” 
displays the value of latitude read by NEMO and translates it to the fixed MEDATLAS format so that 
the user can check that the value is correct and that he did not make any input error. 

 

5.4. The “Validate step” button 
The 5 steps of NEMO have to be done sequentially; it is not possible to start with the “Cruise” or 
“Station” tab, for example. It is not possible to go directly from the “File” tab to the “Data” tab. 
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To go from one step to another one, the NEMO user has to click on the “Validate step” button, on the 
top right part of the NEMO window. 

Then NEMO makes some checks: on format, on mandatory fields… 

If no error is detected, the current step is validated and it is possible to move to the next one. A green 
informative message is written in the error window: “Step validated, you can proceed to next one”, 
and brackets appear on the tab name: 

 

Figure 9 – [File] step is validated, the current step is Cruise description not validated yet 

If errors are detected, the step is not validated and it is not possible to move to the next one. NEMO 
user has to read the error message, correct the input and try to validate again. 

5.5. The “Validate all steps” button 
The “validate all steps” button is only available in the File folder when input file(s) and a validated 
model have been loaded. 

This button allows validating all the steps of NEMO to go directly to the Convert folder for data 
conversion. It is very useful if the user runs NEMO several times with the same model. 

5.6. The “Reset” button 
The “Reset” button is used to reset the current step: it puts back the values to empty or default values 
in all the fields of the current window.  

If the step was previously validated, by clicking on the “Reset” button its status moves back to “not 
validated”. 

5.7. Search function 
For the files linked to a list of values like SHIP, Sea region, Country, and Data Centre: typing in the field 
will filter the list with the characters input like for example for the SHIP: where all ships containing 
‘atal’ are listed 
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6. NEMO settings 
NEMO needs some settings to be able to convert the files, these settings need to be defined before 
the first run of NEMO, using the Menu “Options’> “Settings”. 

This opens the following window: 

 

Figure 10 - Main NEMO Settings window 

Clicking on “+Web Services” opens the following fields: 

 

 Figure 11 - NEMO Settings window, Web services information.  

 

Clicking on “+SeaDataNet CDI summary” opens the following fields: 
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Figure 12 - NEMO Settings window, CDI summary information 

6.1. Default language 
NEMO is bilingual (English – French) and the default language may be changed here. To be taken into 
account, once the language has been changed, the user has to quit and restart NEMO. 

6.2. Default data centre 
The Data centre is the MEDATLAS code (SeaDataNet common vocabularies – List L30) of the data 
centre which manages the data (used only in MedAtlas format). 

6.3. Default directories 
Default directories have to be defined for the models and the data files. These directories will be used 
by default when opening browse windows for data files and models. 

6.4. CDI Author 
The EDMO ID of the organisation creating the CDI metadata is mandatory because it is the EDMO code 
of this organisation and the LOCAL_CDI_ID which determine the iniquity of a CDI record. 
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6.5. CSR Metadata 
EDMO ID of the organisation creating the CSR metadata. This EDMO code is needed to use a local CSR 
Identifier to create a CSR reference (see §7.2.2.1). 

6.6. Mapping and Coupling table 
If the “Generate mapping for SeaDataNet Replication Manager” check-box is clicked, NEMO will insert 
all the converted stations LOCAL_CDI_IDs in a java database included in NEMO software. This coupling 
table gives the mapping between the unique identifier of a CDI element (LOCAL_CDI_ID which 
corresponds to a vertical profile, a time series, or a trajectory) and the file in which this element can 
be found. It is managed by the “Coupling table” menu of NEMO (see paragraph 7.7). 

6.7. ODV date format 
For time-series in ODV output files, you have to choose a date format that can be either ISO8601 or 
Chronological Julian Date; by default the format is ISO8601. 

6.8. Conversion format 
This menu enables the user to choose his default Conversion format which is available on the File tab 
when starting NEMO. 

6.9. Web services 
Web services are used for the “list of values” update, addresses are fulfilled by default when the 
software is installed and they should not be modified. 

NEMO uses 4 different web services: 

 NEMO Web services to update parameters (format and default values of MEDATLAS 
parameters), data types, and cruise lists 

 NAUTILUS Web service is used by IFREMER only for “server initialisation” on the cruise step 

 EDMO Web services to update the list of EDMO IDs. 

 EDMERP Web services to update the list of EDMERP IDs. 

 

If the internet connection makes use of a PROXY, check on “Use Manual Proxy Configuration” and fill 
in information according to your configuration. Please see chapter 9. 

6.10. Default values for SeaDataNet CDI summary 
NEMO can create a file that can be used by MIKADO to generate XML CDI files. If a CDI summary file is 
needed when using NEMO, the user has to click on the “Generate SeaDataNet CDI summary“ checkbox 
and then input the mandatory CDI information. 
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This CDI summary file needs information, which is defined by default in this part of NEMO settings. 
This CDI information may vary from one dataset to another and it is up to the user of NEMO to update 
this information if necessary. 

These default values are, among others, the EDMO codes of the different organisations responsible for 
the data set(s): Data originator, data distributor, or data custodian. At present, the list contains around 
1500 entries, so to help NEMO user to find a value in the list a search function has been developed.  

To open the search function, click on an Edit button… 

 

 

…to open the search window: 

 

Then the user can type in the "Search" field the character string he is looking-up, to filter the list of 
organisations (in the following example, looking up ‘sism’): 

 

Two fields concern the data distribution: 

 Data distribution Website: the default value http://www.sdn-taskmanager.org/ should not be 
changed; it is the address of the central CDI web interface, where SeaDataNet users will have 
to connect to search data. 
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 Data distribution method: gives the access mechanism of the data set. The list of values comes 
from SeaDataNet's common vocabularies (List L07) and gives the access mechanism for the 
data set. 

 

Platform class: this mandatory field for CDI described the type of platform which has collected the 
dataset. The list of values comes from SeaDataNet's common vocabularies (List L06). 

Data set access: this mandatory field for CDI described the data access restriction policies of the 
dataset. The list of values comes from SeaDataNet's common vocabularies (a subset of List L08). 

6.11. Quality flags mapping to SeaDataNet flags 
NEMO can convert input files with quality flags into SeaDataNet quality flags scale. 

Different quality flag mappings can be used and safeguarded within NEMO software. 

The flag window can be opened using the “Edit flags” button, in the Nemo settings window. 

The flag window is divided into 2 parts:  (i) on the top is the list of existing mappings, and (ii) on the 
bottom are the details of each mapping to the SeaDataNet quality flag scale. 

 

Figure 13- Mapping quality flag scale. On the top is the list of existing mappings, and on the bottom are 
details of the selected mapping 

6.11.1. Add a new QC flags mapping 

To add a new mapping: 

 right click on the list of mapping to open the contextual menu: 

 click on “Add” to add a new line to the list of mappings : 
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 change the label of the new mapping : 

 

 

 Then in the bottom part of the window, enter the flag mapping (same principle as previously, 
right-click opens a window which allows adding or removing a line from the mapping table). 
Once a new line is created, the value of the local flag and the mapping between this local flag 
and the SeaDataNet QC flag need to be input as follows: 
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6.11.2. Remove an existing QC flags mapping 

To remove an existing mapping: 

 select the line corresponding to the mapping that needs to be deleted 

 right click on the list of mappings to open the contextual menu : 

 

 click on “Remove” 

6.11.3. Define a default mapping for quality flags 

To define a mapping « by default », right-click on the mapping in the mapping list and select Default in 
the contextual menu. The default mapping is written in bold characters in the mapping list.  

IMPORTANT WARNING: 
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If you are using an existing model, be aware that the flag scale is loaded from the model and is not 
the default flag scale that you may have added or changed in the settings of NEMO after the loading 
of the model. 

If you need to change the flag scale, create a new model or use a model with the same flag scale. 

The mapping used in Nemo conversion will be displayed in the Station description step. 

 If an existing model is used, the mapping is loaded from this model 

 If no existing model is used, the mapping is the default one defined here. 

6.12. Default SeaDataNet flag 
By default when a file is converted to MEDATLAS, ODV, or netCDF format, all quality flags are set to 0 
(No quality control). 

Some users may know that the data that they want to convert have been checked and are all good, it 
is then possible to set the Default SeaDataNet flag to 1 or 2, so that in the output file of NEMO all 
quality flags will be set to 1 (good value) or 2 (probably good value). 

6.13. Restore defaults 
Restore initial configuration values. This action can’t be canceled. 

6.14. Exit NEMO settings 
There are 2 ways of exiting the NEMO settings window: 

 click on Validate to save changes and exit the settings window, or 

 click on Cancel to exit without saving the changes. 

Note that you need to quit and re-start NEMO to take into account new quality flags mappings at 
the Station step.  

7. Running data file conversion 
To convert input file(s), the NEMO user has to proceed with 5 steps, which correspond to the 5 tabs in 
the NEMO interface: 

1. Describe the type of file and the type of measurements (File Tab) 

2. Describe the cruise or the data collection (Cruise Tab) 

3. Describe the station information (Station Tab) 

4. Describe the measured parameters (Data tab) 

5. Convert the input file(s) (Convert Tab) 
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Figure 14- Main screen of NEMO with the 5 tabs corresponding to the 5 steps of conversion 

In this chapter, we describe each of these steps. 

7.1. File description 

7.1.1. Very important requirement 

NEMO can translate almost any kind of ASCII format, but in one execution, NEMO will convert only 
similar files: the files are homogeneous (same data type: e.g. CTD or Bottle but not both), the 
information must be located at the same place in all the files that NEMO will reformat in one execution. 

Examples: 

 If a user wants to reformat the CTD, bottle, and current meters of one cruise, he will have to 
run NEMO three times: one for CTDs, one for bottles, and another one for current meters. 

 If a user wants to reformat a set of XBTs collected during several cruises : 

o The user can do it in one execution if all the XBTs have the same input format. 

o The user must run NEMO three times if he has 3 different input formats of XBTs 
(SIPPICAN, DEVIL, and SPARTON) 
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7.1.2. Description of the type of input file(s) 

The “File” step consists first of a high-level description of the file(s) that needs to be converted: this 
description is included on the left side of the “File” window. 

The first step is to describe the type of dataset that is going to be converted (=input files):  

 Are the data related to one cruise (Process a Cruise)?  

o If yes, is it one file for one cruise (one file for all stations)? 

o Or, is it a set of files in one directory (one file for each station)? 

 Are the data related to several cruises (Process a collection)? 

o If yes, are they grouped by cruises (one directory per cruise)? Or 

o Are they not grouped by cruise (one directory with all the files of all cruises)? 

o Are the files multi-station files or not? 

In case of data conversion related to a collection of cruises or a collection of stations, cruise 
metadata which are mandatory in MEDATLAS are not available, so data conversion in 
MEDATLAS is not allowed; only conversion to ODV and netCDF will be available in “Conversion” 
parameters part. 

Once the previous information is given, the user gives the path to the input file(s) to NEMO, using the 
“Browse” button, and the first file of the first input directory (in case of multiple files) or the specified 
file (in case of one unique input file) is opened in NEMO window: 

 

 

Figure 15– File description screen of NEMO – Left part (in red) for the description of the type of input file(s) 
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Next, the user must declare if the file(s) contains separators (and which one) or not. 

Remark: In the case of a data file with separators, if the data are not displayed as a table (i.e. “use a 
table to display data” is checked in the Data column section), NEMO will rewrite the files without 
separators before moving to the next step. During this stage of rewriting the files, an informative 
message is written in the log window (with progression bars on Data analysis and writing files). The 
files are rewritten in a directory called PF_[name of the input directory]. 

Next, NEMO needs to know if the files are related to vertical profiles, time series, or trajectories (or 
none of them, for biological, flow cytometry, or microlitter variants). 

If you want to generate ODV variants (biological, flow cytometry, or microlitter), choose the 
appropriate one in the Variant section. 

Finally, the user chooses the conversion format: 

 choose between MEDATLAS, ODV, or netCDF format by checking the appropriate box 
(depending on previous parameters, some formats can be disabled) 

 Choose if you want to convert into “One file per station” or to “One unique file for all stations” 
by checking the appropriate box 

 check the “Sort data within stations by increasing reference parameter (Pressure or time)” 
button to be sure that the measured parameters are sorted by the reference parameter in the 
output file. Be careful that doing so you can mix up and down casts CTD data for example. 

The RELOAD button allows one to reload an input file after a change without having to re-open the 
model. 

7.1.3. Description of the file(s) 

Once the type of file has been described, the user must describe the file itself, this second part of the 
“File” step is included on the right side of the “File” window:  
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Figure 16– File description screen of NEMO – Right part (in red) for the description of the input file(s) 

4 information need to be fulfilled for a text file without separators, if the file is a CSV file (File header, 
Station header, End of station, Data termination indicator), a 5th information will have to be fulfilled 
(Data columns selection). 

7.1.3.1. File header 

This field describes the number of lines of the file header. A file header is generally present when it is 
a multi-station file, and there are some lines at the beginning of the file which are related to all the 
stations. These lines are not repeated in the file. 

The number of lines of the file header can be input manually or selected in the left part of the screen 
in the file and then input through the “Set” button (cf. paragraph 7.2.2.1).  

This number of lines can be different from zero only if you selected “Cruise File” in the description of 
the type of input file(s). 
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7.1.3.2. Station header 

 

This section describes the station header. 

When data contains separators, station headers may not have separators. In this case, let the “Station 
header uses CSV separator” unchecked. 

Usually, the station header can be described by its number of lines, if it is constant from one station to 
another. A station header is a set of lines containing information on the station. These lines are the 
lines before the data lines; they are repeated for each station. 

The number of lines of the station header can be input manually or selected in the left part of the 
screen in the file and then input through the “Set” button (cf. paragraph 5.2). 

If the number of lines of the station header changes from one station to another (there is a variable 
length of the station headers), the text that identifies the end of the station header (station header 
termination record text) must be described. If this text is not directly preceding the first data line, the 
user must indicate the number of lines between this text and the first data line. Both information could 
be input manually or selected in the left part of the screen in the file and then input through the “Set” 
button (cf. paragraph 5.2). 

If there are no specific station header lines, let the value equal 0. 

7.1.3.3. End of station 

This field describes the number of lines at the end of a station. These lines may be present when it is a 
multi-station file and there are several lines between each station. The data termination indicator (see 
below) must not be taken into account in this number of lines, so if it is the only line between 2 
stations, the number of lines at the end of the station must be set to zero. 

The number of lines at the end of a station can be input manually or selected in the left part of the 
screen in the file and then input through the “Set” button (cf. paragraph 5.2). 

7.1.3.4. Data termination indicator 

This section describes the indicator of the end of a station in a file. 
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For single station files, most of the time the end of the file (EOF) is the indicator of the end of data, 
but it may be an empty line at the end of the file or a line with a specific text (like in MEDATLAS file for 
example where the last line of a station is a line of default values, that must not be taken into account 
as measurements) that can be input manually or selected in the left part of the screen in the file and 
then input through the “Set” button (cf. paragraph 5.2). 

For multiple station files, Nemo needs information to be able to know that station is changing. 

You can specify how the current station ends, or how the next station begins (if there is no separator 
between stations). 

If you use a separator to indicate the end of the station, this separator can be an empty line or a set of 
specific characters that can be input manually or selected in the left part of the screen in the file and 
then input through the “Set” button (cf. paragraph 5.2). 

If you do not use a separator, you can indicate how the next station starts in two ways: 
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 “a constant character string or a regular expression”, if all stations begin with the same 
character string or different character strings that can be defined by a regular expression 

 For “TEXT FILES (NON-CSV) a character string different from the one of the previous station”, 
if all stations begin with a character string completely different that is present on each line. In 
this case, input the length of the character string that Nemo must compare between each line, 
or select the area in the left part and click on the “set” button. 

 

 For “CSV FILES WITH SEPARATOR: a character string different from the one of the previous 
station”. If all stations contain a value completely different in a given column and present 
on each line. Input the column number (starting from 0) or select it in the ‘file’ window 
and press set. 
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Examples: 

1/ in a MEDATLAS file, the data termination indicator is the line starting with “-999.9 99.999”. Choose 
“One constant character string” and select it in the file window. It is not necessary to input all the lines; 
the first significant characters are enough. 

2/ For ODV multiple stations file, the data termination indicator must be “a constant character string 
or regular expression”, without checking “regular expression”. In that case, NEMO needs to detect the 
text that identifies the beginning of the next station, which is a specific set of characters identifying 
the first line of all the stations in the input file. This text can be input manually or selected in the left 
part of the screen in the file and then input through the “Set” button (cf paragraph 5.2). 

 

3/For a file like the one below: 

1100051103DANI90001004550N03312E690517120012200201000569 

11000512021200000015801846013165800932      013   055  

11000512031200000815501864013366240998      013   078  

1100051103DANI90002004552N03312E690517171517350200100569 

11000512021715000016201844013075970968      006   077  

11000512031715000816001842013095870947      013   077   

1102051103DANI90005004556N03315E690518144015000200110569 

11020512021440000017601869012965660945      016   035  

11020512031440000817001864013055930978      023   048  

1108551103DANI90018004627N03144E690521191019300200050569 

11085512021910000019101736011625170882      013   050  

The first two stations begin with the same string. But the third and fourth stations are not the same (in 
yellow”). 

In this case, the data termination indicator must be “a constant character string or regular 
expression”, with checking “regular expression”. 

The regular expression to use here is “110.*51103DANI” 

Where “.” indicates “any character” and “*” indicates “0 or many times”. 

When the file description is over, click on the “Validate step” button (cf. paragraph 5.4) to move to the 
next step. 

7.1.3.5. Data columns selection (only for CSV files) 

If the file(s) are declared containing separators, the Data columns selection section is enabled: 
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Check “use a table to display data”, to display data in a table (instead of raw text) in the Data tab. 

If the file(s) contains the parameter names as column titles, check “The column titles are in the input 
file”, select the line containing the titles, and click on “Set”. This will allow NEMO to put a column title 
in the data tab like below, where the 3rd line of the file is selected: 

 

Which results in the following data screen, the title of the columns are from line 3 in the file: 
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Note that you can select several lines that will be displayed in the data screen column title like below: 

 Selection of the lines in the file Tab: 

 

 This results in the following display in the data tab: the values of the 4 lines are displayed 
with  a ‘|’ separator in the column titles as shown below: 

 

If the file(s) contains the parameter codes (P01 and/or P09) as column titles, check “The P09 parameter 
codes are in the input file” and/or “The P01 parameter codes are in the input file”, select the line 
containing the P01 and/or P09 parameter codes, and click on “Set”: This will allow an automatic filling 
of the parameter lines in the Data tab (see § 7.4.2.5) : 

 Example of the selection of line with P09 codes for autofill of the data tab with P09 codes 
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 Example of the selection of the line with P01 codes for autofill of the data tab with P01 
codes 

 

7.2. Cruise description 
This step is performed only in case of  
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 processing one cruise: that means that in the “File” tab, “Cruise file” or “Cruise directory” has 
been selected 

and/or 

 converting to MEDATLAS or netCDF format 

 

Figure 17 - Cruise description screen of NEMO 

 

7.2.1. Ways of fulfilling the information 

There are 3 ways of fulfilling the cruise information in NEMO: 

 Server initialisation 

This is specific for IFREMER/SISMER use; it uploads the cruise information from the SISMER 
database using the NAUTILUS Web service. 

 XML initialisation 

This is to import the information from the SeaDataNet CSR XML file (generated by MIKADO or 
other tools). The actual version of NEMO is compatible with the version ISO-19115 and ISO-
19139 of the CSR XML schema. 

 Manual input 

If no automatic import of CSR information is available, the NEMO user can manually input the 
information. 
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7.2.2. Cruise information 

Several sections must be filled; they are described in this chapter. 

7.2.2.1. Reference 

This section describes the reference of the cruise; It concerns all formats: 

 

Cruise reference: MANDATORY 

in the example given, it is a MEDATLAS reference which is composed as described in the MEDATLAS 
format description [2]. 

Note: the cruise reference is used in the LOCAL_CDI_ID which is composed as [Cruise 
Reference]_[Station Code]_[Data type] (station code is optional). 

Local CSR Identifier: OPTIONAL 

If set, this identifier will be used to create the SDN reference in the output file. 

Example: 

< https://csr.seadatanet.org/report/edmo/486/18000510/xml " xlink:role="isObservedBy" 
xlink:type="SDN:L23::CSR"/> 

Nemo checks that the local CSR reference exists in the catalogue for the EDMO code set in the Nemo 
settings “EDMO ID of the organisation creating the CSR metadata” field. If not, Nemo displays a 
WARNING. 

Central CSR Reference: OPTIONAL 

If set, this identifier will be used to create the SDN reference in the output file. 

Example: 

<sdn_reference xlink:href="https://csr.seadatanet.org/report/ 20057238/xml" 
xlink:role="isObservedBy" xlink:type="SDN:L23::CSR"/> 

Nemo checks that the central CSR reference exists in the catalogue. If not, Nemo displays an ERROR. 

Note: it is not possible to input both local and central references. 
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Cruise name: MANDATORY 

Ship: MANDATORY (if unknown set to ZZ99) 

The list of ships is the C17 ship list of SeaDataNet common vocabularies. 

If set, the ship code is automatically used to create an SDN reference in the output file.  

Example: 

<sdn_reference xlink:href="https://www.seadatanet.org/urnurl/SDN:C17::35AY" 
xlink:role="isObservedBy" xlink:type="SDN:L23::NVS2CON"/> 

 

Note: since NEMO 1.6.0, the Cruise tab is available for ODV. The reference is not asked at the end of 
the process. The Cruise column value in the ODV file is the Cruise/collection name field. 

In NEMO 2.0, enriched metadata are provided for the CDI-Summary file for MIKADO, consequently, 
the cruise information is very useful even if not used in the ODV format, but only for the metadata of 
the CDI record. 

7.2.2.2. Location 

This section describes the temporal and geographical location of the cruise. It concerns MEDATLAS 
(mandatory) and netCDF (optional). The 3 fields are mandatory in MEDATLAS: 

 

Region: the list of regions is the C19 sea areas list of SeaDataNet common vocabularies. 

7.2.2.3. Data source 

This section describes the source country, laboratory, project, and chief scientist of the cruise. It 
concerns MEDATLAS (mandatory) and ODV, netCDF (optional). The country and the chief scientist are 
mandatory in MEDATLAS. 
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Country: the list of countries is the C18 IOC country codes list of SeaDataNet common vocabularies. 

Laboratory, Chief scientist, and Project are free text fields. 

EDMERP Codes: The list of research projects linked to the data set. A right-click in the EDMERP table 
open the contextual menu allowing one to add or delete projects from the list: 

 

These EDMERP codes are used in the output files as lines of “sdn_reference” linked to the EDMERP 
catalogue (see example below): 

<sdn_reference xlink:href="https://edmerp.seadatanet.org/report/12297" xlink:role="isObservedBy" 
xlink:type="SDN:L23::EDMERP"/> 

<sdn_reference xlink:href="https://edmerp.seadatanet.org/report/11760" xlink:role="isObservedBy" 
xlink:type="SDN:L23::EDMERP"/> 

<sdn_reference xlink:href="https://edmerp.seadatanet.org/report/11824" xlink:role="isObservedBy" 
xlink:type="SDN:L23::EDMERP"/> 

Note: for the MEDATLAS format, the project field, of the cruise header, will contain the list of the 
EDMERP codes separated with comas, as it is limited to 28 characters maximum, it will contain only 
the first 4 projects of the list. 

Example of cruise header with a list of projects, in MEADATLAS format: 
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7.2.2.4. Archiving centre 
This section describes the data centre where data are archived and the MEDATLAS code for the data 
availability. It concerns MEDATLAS (mandatory) and netCDF (optional). 

 

Data centre: the list of data centres is the L30 MEDATLAS data centres of SeaDataNet common 
vocabularies. By default, the data centre is the one given in NEMO settings (cf. paragraph 6.2). 

Confidentiality: it corresponds to the MEDATLAS code for data availability that can take one of the 
following values: P – Public, L – Limited, and C – Confidential.  

7.2.2.5. Type of data 

This section deals with the ROSCOP code of data found in the files that are going to be converted and 
concerns only the MEDATLAS format. 

 

The data type code is the ROSCOP code; it is the C77 ICES ROSCOP data types list of SeaDataNet 
common vocabularies. 

At least one data type with Sensor at true is mandatory. 

“Number” represents the number of stations with the corresponding data type in the file; it cannot be 
equal to 0. In this example, the cruise file contains 8 CTD stations; each of them has dissolved oxygen 
measurements. 

A right-click on the list opens the following window: 
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To add a code to the list, click on “List selection” and you will get a window to choose a new data type: 

 

When the data type is selected in the list, click on “Select” to add it to the list of data types of the 
cruise, and then change the number of stations which is set to 0, by default. 

To delete one or several data types: select the line(s) to be deleted by left click on the data type lines 
(use Shift and/or Control to select several lines), then right-click on the list and select “Delete current 
type” in the menu.  

It is also possible to move up or down a current data type in the list. 

7.2.2.6. Comments 

This section is used to input comments about the cruise or the data measurements. There is no 
limitation on the number of comment lines. 

 

When the cruise description is over, click on the “Validate step” (cf. paragraph 5.4) to move to the next 
step. 

7.3. Station description 
This step is performed to indicate to NEMO where to find the mandatory or important information in 
the station header(s) of the file(s). This information is changing following the File type (vertical profiles, 
time series, or trajectories) and the variant (physico-chemical, biological, microlitter, or flow cytometry 
data)  
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Figure 18 - Station description window with all possible fields 

Mandatory fields are Station code, Data type, Time, Date, Latitude, and Longitude for all data types 
and variants. 

Sensor Depth and Sampling rate are mandatory for time series 

Fields Acquisition History, Comments, Surface Sample, UT/Conversion, End Latitude, End Longitude, 
End Depth, and Sampling Rate are not mandatory and can’t be described on a data line.  

End Latitude, End Longitude, and End Depth (if existing) are the last data line value of Latitude, 
Longitude, and Depth. This information can be described in the station tab or can be automatically 
filled by NEMO if read in the data lines. 

For trajectories, the fields Latitude, Longitude, and Depth (if existing) must be described on a data line 

When the station description is set, click on “Validate step” (cf. paragraph 5.4) to move to the next 
step. 

Note that : The mandatory information of a station can be located in a part of the input file without 
separators, in that case the location of the information in the input file will be set as a start and end 
characters like below: 
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On the contrary, when this information is located in a CSV station header, then the location of the 
information in the input file will be set as a column number, like here below: 

 

7.3.1. Considerations on LOCAL_CDI_ID 

The LOCAL_CDI_ID is built by Nemo. It is composed as [Cruise Reference]_[Station Code]_[Data type]. 

The station code is optional. 

Cruise reference is set in the Cruise tab and is described in §7.2.2.1. 

Station code and Data type are set in the Station tab and are described respectively in §7.3.2 and 
§7.3.3. 

7.3.2. Station code 

The station code can be an incremental number starting at a number given by the user (default starting 
number is 1) or can be in the station header and input in NEMO using the set and test buttons 
(paragraphs 5.2, 5.3), or can be fixed for several stations (in the case of biological, microlitter and flow 
cytometry variants) 
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Remark: If the station code is located within the filename, use 0 as the line number, and give the start 
and end characters in the file name. 

The station number field is used in two ways: 

 As station number, which is the second column in ODV files, the SDN_STATION variable in 
SeaDataNet NetCDF 

 As part of the MEDATLAS  reference in the MEDATLAS format 

 As part of the LOCAL_CDI_ID 

 

In ODV, a trajectory is considered as a series of stations with one point of measurement at each station, 
but the LOCAL_CDI_ID is the same for all the stations. In MEDATLAS and netCDF a trajectory is only 
one station within which latitude and longitude are considered as measured parameters. The station 
number cannot be incremental. 

 

If you need to set a unique LOCAL_CDI_ID, you can choose not to use the station number as the middle 
part: uncheck the “Use as the middle part of the LOCAL_CDI_ID” check box. 

This can be useful for example for trajectories, ADCP data presented as successions of vertical profiles, 
or for some biological (such as the BioODV_Demfish_monoCDI example in the 
“TemplateAndExamples_BioODV.xls file) and microlitter variants which are “sort of” trajectories and 
have only one LOCAL_CDI_ID for all “stations. 

7.3.3. Data type 

It is the ROSCOP code of the instrument (H10 - CTD for example) used for data collection; it is selected 
in the list of data types input during the previous step (cruise description) or can be input manually by 
the user only in ODV and netCDF for data types that do not exist in the list. 

If processing a collection of files, the “Data type” field is not available, it will be asked during the 
conversion step. 

Note: the data type is used in the LOCAL_CDI_ID which is composed as: [Cruise Reference]_[Station 
Code]_[Data type] (Station Code is optional) 
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7.3.4. Acquisition history 

They are 2 lines for comments about the method and/or instrument used for data collection. They can 
be manually or automatically input, in the following fields. 

Not available in netCDF. 

 

7.3.5. Comments 

Comments about the station can be manually or automatically inputted. There is no limitation on the 
number of comment lines. 

If the comment is spread among several lines which do not have the same length, click on “Variable 
end of line position”. 

Not available in netCDF. 

 

7.3.6. Surface samples 

Same principle as Acquisition history, 2 lines for comments about surface samples if there are some. 

Not available in netCDF. 

7.3.7. UT/Conversion 

This field is to manage non-universal time in the input files. 

If the station time in the input file is TU-5, type ‘5’ (or read by automatic input) in the UT/Conversion 
field and NEMO will add 5 hours to the input time. If the time in the input file is TU+5, type ‘-5’ in the 
field. 

The default value is zero, for this field. 
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7.3.8. Time 

This field concerns the time of stations.  

The user needs to input the format in which time is provided in the input file and then, he has to set 
and test the value (paragraphs 5.2, 5.3). 

 

To describe the format, the user must either select a predefined value in the list, or he can create its 
format within the following: 

hh: hour expressed in 2 digits (hh24 indicates time on 24 hours) 

mm: minutes expressed in 2 digits 

ccc: hundredth in the time expressed in 1 up to 7 digits 

ss: seconds expressed in 2 digits 

ttttt: seconds expressed in 1 up to 5 digits 

PM: allows NEMO to read PM and AM time 

If date and time are inseparable, you can select the value and use the same date-time pattern for 
both fields. For example: for CSV files with date and time in the same column, ISO datetime formats 
or datetime in Julian days. 

Examples of valid formats for time: 

22:30:15  hh24:mm:ss 

10-12 AM hh-mm PM 

17.125  hh24.ccc (converted to 17:07:30.000)  

2008/02/05 15:32 YYYY/MM/DD hh24:mm (result is 15:32) 

2008-08-12T03:16:00 ISO8601  

2008-08-12T03:16:00.002 ISO8601  

2008-08-12T03:16 ISO8601  

2446101.156 JULIAN DAY 
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Time may be unknown for some stations of vertical profiles and in that case, a default value must be 
specified, user has to click on Default value and input this value in the corresponding field like in the 
example below 

 

Remark: In the test field, time is displayed in ISO format, if UT/conversion field contains a value 
different from 0, the displayed time takes into account the time conversion to UT. 

7.3.9. Date 

This field concerns the date of stations.  

The user needs to input the format in which the date is provided in the input file and then, he has to 
set and test the value (paragraphs 5.2, 5.3). 

 

To describe the format, a user must either select a predefined value in the list, or he can create his 
format within the following: 

YY or YYYY: year expressed in 2 or 4 digits 

MM: month expressed in 2 digits 

MMM: month expressed in 3 alphabetic characters 

DD: day in the month expressed in 2 digits 

Note that the format for the date is case-sensitive; mm means minutes and not month (MM). 

For CSV files with date and time in the same column, declare the datetime pattern in both date and 
time fields. 

Examples of valid formats for date: 

2008/07/10  YYYY/MM/DD 

86-07-10  YY-MM-DD  

Jun 10 2002  MMM DD YYYY 
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2008/02/05 15:32 YYYY/MM/DD hh24:mm (result is  2008-02-05) 

2008-08-12T03:16:00  ISO8601  

2008-08-12T03:16:00.002  ISO8601  

2008-08-12T03:16  ISO8601  

2446101.156  JULIAN DAY 

In the test field, the date is displayed in ISO format 

7.3.10. Latitude and Longitude 

These fields concern the latitude and longitude of stations.  

The user needs to input the format in which latitude and longitude are provided in the input file and 
then, he has to set and test the values (paragraphs  5.2, 5.3). 

 

To describe the format, the user must either select a predefined value in the list: 

 predefined format 

 Decimal degrees for a file with separators: available only for files with a separator, in which 
latitude and longitude are given in the CSV columns. Decimal degrees, regardless of the 
number of characters. 

Or the user can describe his format within the following:  

N: expresses the hemisphere. Input values have to equal N or S in the case of latitudes and W or E in the case of 
longitudes 

+: expresses the hemisphere. Input values have to equal ‘ ’ or ‘+’ to express N in the case of latitudes, E in the case 
of longitudes, and ‘-’ to express S in the case of latitudes, W in the case of longitudes 

DDD or DD or D: Degrees 

DDD.ddd or DD.ddd: Degrees in decimal values. The maximum number of D must be 3 in the case of longitudes and 
2 in the case of latitudes 

DDD.ddd or DD.ddd: Degrees in decimal values. The maximum number of D must be 3 in the case of longitudes and 
2 in the case of latitudes. The number of ‘d’ characters expresses the number of decimals. 

MM: Minutes 

MM.mm: Minutes in decimal values. The number of ‘m’ characters expresses the number of decimals. 

SS: Seconds 

Decimal degrees for a file with separators 

Examples of valid formats for latitude and longitude: 

W123 10.25  NDDD MM.mm  

7.12345   +D.ddddd or Decimal degrees for a file with separators 

-123. 175  +DDD.ddd or Decimal degrees for a file with separators 

mailto:sdn-userdesk@seadatanet.org
http://www.seadatanet.org/


 

sdn-userdesk@seadatanet.org – www.seadatanet.org 

SeaDataNet - The pan-European infrastructure for marine and ocean data management 

 54 

S45 10’ 55’’  NDD MM SS 

49° 40.685' NDD° MM.mmm' N" 

In the test field, latitude and longitude are displayed in MEDATLAS format. 

Click on “variable end of line position or variable start position” if all latitudes and longitudes do not 
end or start at the same character in every station (this often happens with not significant zero values) 
and if the file is not with separators 

For example:  
Latitude: +25.205  
Latitude: +25  
Latitude: +25.15 
Latitude:  -0.15 (‘-‘ 1 character to the right of ‘+’)   

These 4 lines (in 4 different stations of the same dataset) will be described as +DD.ddd with “variable 
end of line position or variable start position”. 

7.3.11. Bottom depth 

This field concerns the bottom depth of stations, which must be given in metres in the input file. This 
field can be input automatically or set to “no value”. 

 

If the file is not a CSV file, click on “variable end of line position or variable start position” if all bottom 
depths do not end or start at the same character in every station (this often happens with not 
significant zero values) 

Some files could contain default values if the bottom depth is not measured (-999, for example). To 
describe this value, click ‘Default value’ and enter the corresponding value in the text field. 

7.3.12. End Latitude and End Longitude 

These fields concern the latitude and longitude of the end time of the time series.  

By default, if not input, the values will be the same as “Latitude” and “Longitude” which are considered 
as the position at the start time of the time series. 

Input in these fields is the same as for “Latitude” and “Longitude” described for vertical profiles. 

Not available in netCDF. 
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7.3.13. End Bottom depth 

This field concerns the bottom depth at the end time of the time series.  

By default, if not input, the value will be the same as Depth which is considered as the bottom depth 
at the start time of the time series. 

Input in this field is the same as for “Depth” described for vertical profiles. 

Not available in netCDF. 

7.3.14. Sensor’s depth 

This field concerns the depth of the sensor measuring time series. It must be given in metres in the 
input file. This field can be input manually or automatically. 

7.3.15. Magnetic Declination 

This field concerns the magnetic declination at the location of the time series, useful for current 
meters. The declination is a signed integer:  W007 declination must be input as -7 and E005 as +5 or 5. 
This field can be input manually or automatically. 

Not available in netCDF. 

7.3.16. Sampling Rate 

This field concerns the sampling rate of the sensors. This sampling rate can be input manually, or 
automatically.  

NEMO will calculate it automatically if time and date are selected in the first line of measurements.  

The unit of the sampling rate is Second. If it is not given in seconds in the input file, it must be converted 
by using the field “Conversion formula” (for example: if the sampling rate is given in Hours in the input 
file, input *3600 in the formula). 

 

For time series If time or date is selected in the first line of measurements in the file displayed in the 
NEMO window, the sampling Rate field is disabled, and NEMO will calculate it. 
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7.3.17. QC Flags 

This part concerns the quality flags that could exist in the input file. 

QC Flags can concern metadata and/or data. 

 Header QC (metadata) flags are only used in MEDATLAS format, they concern Date/Time, 
Latitude, Longitude, and Bottom depth. 

 Data QC flags can be used in all formats. 

If some quality flags exist in the input file, it is necessary to have their mapping with the SeaDataNet 
flag scale. To do so, it is possible to add and remove values in the mapping list or to load an existing 
mapping (paragraph 6.11). To open the menu, right-click on the mapping table. 

Remark: if the input file has the same quality flag scale as SeaDataNet, no mapping is necessary. 

 

When mapping is done, the location of the metadata quality flags can be input. 

Right-click on the table to open the menu: 
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Then you can add or remove a line. In the example, above, the user is adding a line for the longitude 
flag. 

Once one line is added, the flag has to be selected in the file (left part of NEMO window) and set in the 
table by clicking on Set start/end in the menu. The value can be tested by clicking on “Test” in the 
menu. 

When the station description is over, click on the “Validate step” (cf. paragraph 5.4) to move to the 
next step. 

7.4. Data description 
This step is performed to indicate to NEMO where to find the data measurements in the input file(s). 
This information concern the name and unit of the measured parameters, their default values (found 
in the input file when the parameter is not measured), and the format in which the parameter will be 
written in the output file. 

 

Figure 19- Data description window, text file without separators 

If the file(s) contains separators and if the data columns selection section was chosen in the File tab, 
data are displayed in a table: 
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Figure 20- Data description window: data displayed in a table 

First choose the parameters list to use: P09, P01viaP09, or P01viaP02 (P01viaP02 is disabled for 
MEDATLAS conversion and P09 is disabled for netCDF conversion). 

Then choose the measure type: “below sea surface”, “below sea bed”, or “above sea level”. 

If input files concern biological, flow cytometry, or microlitter variants, the mandatory parameters are 
automatically added. Some of the mandatory parameters allow several P01 (eg. SamplingEffort in 
biological variant can be either AREABEDS, VOLWBSMP, LENTRACK, AZDRZZ01, or VOLFFMXX). By 
default, “samplingEffort” is set to VOLWBSMP, the user can remove this parameter and choose 
another one. Nemo will check if the mandatory parameters are present during the tab validation. 

See the variants documentation: [4], [5], [6], [7], [8], [9]. 

If input files concern physico-chemical vertical profiles, one of the following parameters is mandatory: 

 P09 or P01viaP09 P01viaP02 
below sea surface PRES or DEPH a P01 parameter chosen 

from the AHGT P02 list 
below sea bed DPSF a P01 parameter chosen 

from the AHGT P02 list 
above sea level ALTS a P01 parameter chosen 

from the AHGT P02 list 

Then provide the vertical reference: this step is needed to control the user input: the existence of 
mandatory parameters, and their position in the list, it also identifies the parameters that will be used 
by NEMO for automatic additions of calculated parameters: 

The parameters listed in these fields are filled from the parameters added in the table. 

You have to add the appropriate parameters (see table above) in the table to be able to select a value 
in these fields. 

If P09 or P01viaP09 is used, the vertical reference fields will be automatically selected when the 
‘validate step’ button is clicked. 

If P01viaP02 is used, you will have to select manually the vertical reference. 
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If input files concern physico-chemical or flow cytometry time series, the date and time of 
measurements will be automatically added to output files, they do not need to be described in the 
measurement description. 

If input files concern physico-chemical or flow cytometry trajectories date, time, latitude, longitude, 
and bottom depth (if existing) of measurements will be automatically put in output files, they do not 
need to be described in the measurement description. 

If input files concern bathythermograph profiles, you can choose a fall rate via the L33 BODC list. 

This code will be associated with the vertical reference parameter selected in the “Vertical references” 
section and will be written in the SDN Mapping in MEDATLAS and ODV, or the variable attributes in 
netCDF. 

Example in ODV: 

//<subject>SDN:LOCAL:PRESPR01</subject><object>SDN:P01::PRESPR01</object><units>SDN:P06::P
ASX</units><instrument>TOOL0804</instrument><fallrate>745</fallrate> 

Since version 1.4.4, NEMO accepts non-numeric parameters for ODV format only. Click on the left-
side checkbox to specify that the parameter is not numeric. 

7.4.1. Menu of the table of measurements 

Right-click on the table of measurements opens the following menu:  

  

Figure 21 – Parameters menu for a text file without separators and a conversion to MedAtlas (left)                      
and for a text file with separators for a conversion to netCDF (right)  

The available items in the Parameters menu depend on the context: 

 Select a P06 unit,  is only available if  P01 via P02 Parameter list is chosen, and if the parameter 
is a numerical measurement 

 Select a format is only available if  P01 via P02 Parameter list is chosen  

 Select a standard name is only available for conversion to the netCDF format 
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Auto-fill next parameter column and Auto-fill next parameter flags are only available for CSV files and 
if at least one  column number already exists in the parameter table of the data tab. The role of each 
item on the menu is explained hereafter. 

7.4.1.1. Set start/end or Set column number 

Used to set the start and end character (ASCII file, not CSV) or the column number (csv files) of the 
selected parameter. 

Example of a Text file without separators: start and end character of the parameter in the input file: 

 

Example of a CSV file with separators: Column number of the parameter in the input file: 

 

7.4.1.2. Auto-Fill next parameter column  

For a CSV file, used to fill automatically the column number of all the parameters in the table, once the 
position of at least one parameter has been input. 

7.4.1.3. Update test 

Used to insert the value in the test fields including “Test” (for the measured parameters), “Test (input)” 
for the value of the quality flag read in the input file, and “Test (output)” for the value of the quality 
flag in the output file.  

The user can then checks that the displayed values are correct and correspond to the values of the 
input files. 

7.4.1.4. Select an instrument 

Used to add an instrument via the L22 list. If several lines are selected in the table of parameters, the 
same instrument will be added for all selected parameters 

7.4.1.5. Delete instrument 

Used to delete the instrument of one or several parameters (if several line are selected). 
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7.4.1.6. Select a P06 unit 

Used to add a unit via the P06 list when using P01 via P02 parameters. Visible only in this case. If several 
lines are selected in the table of parameters, the same unit will be added for all selected parameters. 

7.4.1.7. Select format 

Used to add a format via a predefined list. The format can be manually input; this menu helps to choose 
the format with examples. If several lines are selected in the table of parameters, the same format will 
be added for all selected parameters 

Visible only in if using P01 via P02 parameters. 

7.4.1.8. Set conversion value 

Used to set a conversion value (in case of different units in the input file and the output file) of several 
parameters (if several line are selected). 

7.4.1.9. Set input default value 

Used to describe the default value used in the input file for a parameter. If several lines are selected in 
the table of parameters, the same “Input Default value” will be added for all selected parameters. 

7.4.1.10. Select Standard Name 

For netCDF only, used to select the standard name of one parameter. If several lines are selected in 
the table of parameters, the same “Standard Name” will be added for all selected parameters. 

7.4.1.11. Set Long Name 

For netCDF only, used to describe the long name of one parameter. If several lines are selected in the 
table of parameters, the same “Long Name” will be added for all selected parameters. 

7.4.1.12. Add Parameter 

Used to add a new parameter in the table of measured parameters. (see paragraph 7.4.2) 

7.4.1.13. Delete Parameter 

Used to delete one or several parameter lines (if several line are selected) from the parameter list. 

7.4.1.14. Set Flag 

Used to set the start and end characters or the column number of the quality flag of the selected 
parameter. 

7.4.1.15. Auto-Fill next parameter flags 

Used to fill automatically the column number of all the flags in the table, once the position at least one 
flag has been input. 

mailto:sdn-userdesk@seadatanet.org
http://www.seadatanet.org/


 

sdn-userdesk@seadatanet.org – www.seadatanet.org 

SeaDataNet - The pan-European infrastructure for marine and ocean data management 

 62 

7.4.1.16. Delete flag 

Used to delete the quality flag information of the selected parameter(s). 

7.4.2. How to add a parameter in the table 

To add a parameter in the table, right-click on the data table and click on Add a Parameter. 

It opens a parameters selection window listing P09 or P02 parameters, depending on which 
parameters list is applicable. 

7.4.2.1. Using the P09 parameter list 

To add a parameter in the table, right-click on the data table and click on Add a parameter. 

It opens a parameters selection window listing P09 parameters. 

 

Figure 22- The parameters selection window displays the P09 list of SeaDataNet (MEDATLAS codes for 
parameters) 

Select a parameter in this list (use filter to find a specific parameter: in the example below, there is a 
filter on “current”), then press “Select”. 
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The selected parameter is added to the table, with some values filled by default. The default and the 
format values linked to the parameter are downloaded from the parameters list of the NEMO Web 
service. 

 

Format, input default value (and output default value if MEDATLAS) can be manually modified. 

7.4.2.2. Using the  “P01 via P09” parameter list 

To add a parameter in the table, right-click on the data table and click on Add a parameter. 

It opens a parameter selection window listing P09 parameters. 

The parameters selection window displays the P09 list of SeaDataNet (MEDATLAS codes for 
parameters), as in the previous case (using the P09 parameters list). 

The selection of a parameter in this list opens a second window, displaying the P01 parameters list: 
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Select a parameter in this list (use filter to find a specific parameter, in the example below there is a 
filter on “east”).  

 

Then press “Select” to add the selected parameter in NEMO’s table, with some values filled by default. 
The default and the format values linked to the parameter are downloaded in the parameters list of 
the NEMO Web service 

 

Input default value (and output default value if MEDATLAS) can be manually modified. The format can 
be manually modified if the parameter is numerical. 

7.4.2.3. Using P01 via P02 parameter list 

To add a parameter in the table, right-click on the data table and click on the Parameter list, menu. 
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It opens a parameters selection window listing P02 parameters. 

 

The selection of a parameter in this list opens a second window, displaying the P01 parameters list: 

 

Select a parameter in this list (use filter to find a specific parameter  

 

Then press “Select” to add the selected parameter in NEMO’s table, with some values filled by default.  
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For numeric parameters, unit, Format, input default value) can be input. 

For non-numeric parameters, an input default value can be set. The unit cannot be modified. 

To set a unit, right-click on the parameter and select “select a P06 unit” in the context menu. 

The unit can be also modified using this context menu. 

7.4.2.4. Fulfill parameter values and test 

7.4.2.4.1. T column 

This column is only available in ODV format. 

Check the checkbox to indicate that the parameter is non-numeric (ie. Geological description) 

7.4.2.4.2. Label 

This column is available only  

if you use ODV as conversion format 

AND 

if you use P01 parameters (P01viaP02 or P01viaP09) 

In other cases, this column will be hidden. 

This field is used to choose your parameter label for conversion. 

By default, the parameter label (i.e. column title in ODV and SDN mapping) is the P01 parameter code. 

If you put a value in this field, this value will be used instead of the parameter P01 code. 

If you use this column, P01 codes / personal labels mapping will be saved in a file: 

under [NEMO_installation_directory]\ resources\userParametersLabels.xml. 

Already saved personal labels will be automatically filled by NEMO. 

You can always modify them in the parameter table. This will update the mapping file. 

7.4.2.4.3. Standard name 

This column is available only in netCDF format. 

The standard name is not mandatory in netCDF but is highly recommended for CF compliance. So if a 
standard name corresponds to the measured parameters, it is recommended to use one. 

7.4.2.4.4. Conversion 

This field is used to input a conversion formula which should be like x*1000+3; with x the value read 
in the input file(s). This field is not writable for non-numeric parameters. 

Example: 

In the example below, the East component of the current is given in millimetres/second; as in the 
output file, it is in metres/second, a 0.001 factor has to be applied to the value read in the input file. 
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Figure 23 - Example of an input value converted through a formula 

7.4.2.4.5. Test 

This field displays the value as it will be written in the output file (taking into account the format input 
and the conversion formula, if any, by the user).  

To input value in the test field, right-click in the table and choose “Update test” in the context menu; 
the start and end fields must have been input before. 

In the Figure 23 example, the test value takes into account the conversion formula and the output 
format (column format) which says 3 decimal digits. 

7.4.2.4.6. Start-End/ Column number 

These fields indicate the start character and the end character or the column number of the parameter 
in the data line. 

To input the values in these fields, you have to: 

 Select the parameter line,  

 right click to open the context menu and choose Set start/end or Set column number, 

 select the value of the parameter in the first line of the data file for a text file without 
separators, or select the header of the column of the parameter for a CSV file displayed as 
columns. 

. 
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Figure 24 – Data screen  - the input file is a CSV file 

Figure 24 shows the results on a CSV file when all parameters have been input. The selected parameter 
DEPH appears in grey in the parameter list and is shown in orange (column 8) in the CSV file, if there is 
an associated flag, it appears in purple.   

 

Figure 25 – Data screen – the input file is  a text file without separators 
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Figure 25, shows the results on a text file without separators when all parameters have been input. 
The selected parameter PRESPR01 appears in grey in the parameter list and is shown in orange (from 
character 94 to character 100) in the text file. 

Remark: for text files without separators, do not forget to take the maximum length of the value 
into account; it may not be the same length as the one on the first line of data. 

Example:  

In Figure 25, the first value of the current direction is 61.000 

You have to select additional blank spaces to take into account further values that contain more digits 
like 101.000 on the second line (one additional character has to be selected) or the default value that 
could be -9999. (two additional characters have to be selected). 

7.4.2.4.7.  Autofill next parameter column 

This can be done if the input file is a CSV file and if the parameter list in NEMO  is in the same order 
as the parameters in the file. You can then proceed to the following steps: 

 Once you have entered all parameters in the parameter list, select the column number of the 
1st parameter of the list 

 With the cursor on a parameter line with already a column number, right-click and choose 
“Auto-Fill next parameter column”, this will open the following window: 

 

Figure 26 – Data screen – Auto-Fill next parameter column window 

 Choose 1 if the parameter columns are every column in the input file, and choose 2 if the 
parameter columns are every 2 columns in the input file like in the example of Figure 26 

 Click on OK 

 All the column number of the parameters are automatically filled as shown below: 
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7.4.2.4.8. Format 

This field describes the output format (in the output file) of the measured parameter, including the 
format of the default value. 

The user has to describe the output format within the following: 

%xd:  x = number of digit,  

d for integer 
 %3d  150 
 %5d  15000 

%+xd: same than %xd but for signed values 
 %+4d  +150 or -150 
 %+6d  +15000 or -15000 

%x.yf = x= total number of digits included the decimal point 

  y= number of digits to the right of the decimal point 

  f: for decimal number 
   %6.3f  12.124 
   %5.1f  123.4 
   %7.5f  1.12345 

 %+x.yf :  same than %x.yf but for signed values 
   %+6.3f  +12.124 or -12.123 
   %+5.1f  +123.1or -123.1 
   %+7.5f  +1.12345 or -1.12345 

Input def. value: 

This field describes the values found in the input file where the parameter is not measured. 

This input value can be any type of character (number, alphabetic). It must be kept empty if the input 
default value is empty. 

7.4.2.4.9. Output def. value 

This field describes the values written in the output file where the parameter is not measured. 

It is not used in ODV format (where the default value is an empty string) nor in netCDF format (where 
the default value is always NaN). It is used in MedAtlas format only, where the output value must be a 
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number (often a suite of ‘9’) in the same format as the measured parameters described in the format 
column. 

7.4.2.5. Automatic filling of the parameter lines 

This functionality, added in NEMO 2.0, allows the user to automatically input the data lines, if the 
parameter codes (P01 or P09) exist in the input data file(s) and if the line containing these codes has 
been input in the File Tab, fields “The P09 parameter codes are in the input file”  and/or “The P01 
parameter codes are in the input file “ (see §7.1.3.5). 

With these 2 conditions met, on the Data tab, the ‘Auto-Fill” action is available in the contextual menu 
of the parameter table as shown in Figure 27.  

 

Figure 27 –Auto-Fill P09/P01 parameter available 

Clicking on the Auto-fill P09/P01 parameter gives the result shown in Figure 28: the field CODE, UNIT, 
START, END, FORMAT, and OUTPUT format are automatically filled-in in the parameter list. 

mailto:sdn-userdesk@seadatanet.org
http://www.seadatanet.org/


 

sdn-userdesk@seadatanet.org – www.seadatanet.org 

SeaDataNet - The pan-European infrastructure for marine and ocean data management 

 72 

 

Figure 28 – Data screen – Parameter lines automatically filled in with P09 codes  using the Auto-Fill  menu 

The user has to check that the autofill is correct and more particularly the units and the format 
automatically generated; the user also may have to complete the information with default values, 
instrument …. 

Note: 

There is a specific case for the MedAtlas transcoding, if the input file contains both P09 and P01 codes: 
they can be both used, this will allow to use more detailed P01 codes in the SDN_mapping lines than 
the generic ones used by default for the P09/P01 mapping. 

7.4.3. How to move a parameter in the table 

The previous “Move current parameter down”, “Move current parameter up”, “Move current 
parameter down to bottom”, “Move current parameter up to top” have been replaced by the drag and 
drop function in the table of parameters. You can move one or several parameter(s) by selecting one 
or several parameter line(s) and then drag and drop it (them) where needed. 

7.4.4. How to keep existing quality flags 

In the table of measured parameters, information on quality flags that may exist in the input file(s), 
can be input in the 4 last columns of the table of measured parameters (Test (input), Test (output), 
Start flag, End flag). 

3 choices are available in the context menu of the parameter table: Set flag, Autofill next parameter 
flags and Delete flag, they are described hereafter 
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7.4.4.1. Set flag 

To input the start and end positions or the column number of quality flag information: 

 Select the parameter line,  

 Right-click to open the parameter menu and choose Set flag,  

 Select the value of the flag in the first line of the data file for a text file without separators, or 
select the header of the column of the flag for a CSV file displayed as columns. 

In the example below, the parameter Depth has a quality flag in the 9th column of the data line, 
the Phosphate on the 11th column… For all of them, the input value of the QC flag is the same as 
the output value, no conversion of flag scale was necessary (here 1). 

The parameter(s) selected in the parameter table (ADEPZZ01 in grey below) and its corresponding 
quality flag are highlighted in the upper part of the screen (Parameter DEPH in Orange in column 
11, flag QC DEPTH in purple in column 12) 

  

 

7.4.4.2. Autofill next parameter flags 

Used to fill automatically the QC flag position of all the parameters in the table. This can be done if the 
input file is a CSV file and if the parameter list is in the same order as the parameters in the file. You 
can then proceed to the following steps: 

 Once you have entered all parameters in the parameter list, select the position of the flag of 
the 1st parameter of the list 

 With the cursor on a parameter line with an existing flag position , right-click and choose 
“Auto-Fill next parameter flags” and proceed as for “Auto-Fill next parameter column” 
described before (Figure 22). 
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7.4.4.3. Delete flag 

To delete flag information from the table of measurements: 

 Select the parameter line(s) where you want to delete this information 

 Click on “Delete flag” in the menu 

The current flag scale conversion is the one loaded in the previous step (Paragraph 7.3.17, QC flags). 

When the data description is over, click on the “Validate step” (cf. paragraph 5.4) to move to the next 
step. 

7.5. File conversion 
This is the last step of NEMO; once the description of the input file(s) is completed, it is possible to run 
the conversion to either ODV, netCDF, or MEDATLAS format. 

This conversion step generates: 

 output file(s) in the needed format 

 Some mandatory parameters may be added, depending on several criteria (see paragraph 
7.5.2) 

 If “Generate SeaDataNet CDI summary” is clicked in NEMO settings, a CDI summary file will be 
created while NEMO is converting the input file(s). It is a Comma Separated Values (CSV) file 
that is directly usable by Mikado to generate a CDI XML export, corresponding to the stations 
that are converted to ODV, netCDF, or MEDATLAS format.  

 If “Generate mapping for SeaDataNet Replication Manager” is clicked in NEMO settings, 
mapping information (for all the stations that are converted to ODV, netCDF, or MEDATLAS 
format) is inserted in the local database of NEMO.  

7.5.1. Running file conversion 

Click on the “Start conversion” button, then the user is asked: 

o to enter a name for the CDI-summary file if “Generate SeaDataNet CDI summary” is 
clicked in NEMO settings 

o to enter a name for the output directory or the output file 

o to enter a name for the output directory prefix if “Generate mapping for SeaDataNet 
Replication Manager” is clicked in NEMO settings. This prefix will be subtracted from 
the file name in the mapping table.  

For example if  

output file name = C:\username\NEMO\cruise_name\file_name 

and  output directory prefix = C:\username\NEMO 

file name in the mapping table will be: cruise_name\file_name 

Then the conversion starts and the user is informed about its progression in the “Log” tab at the 
bottom of the window. 

When the conversion stops: 

 there may be an error, detailed in the “Log” tab in red, or 

 conversion is completed and a green message informs the user that the conversion is OK. 
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 The corresponding batch command is given in the log window, it can be copied (removing 
line feeds) to be used in a batch file. 

 

Figure 29 File conversion window, with an ODV conversion completed 

7.5.2. Automatic insertion of parameters in the output file(s) 

Depending on the chosen output format and the data type (vertical profile, time-series, trajectories) 
NEMO automatically adds some parameters to the output file. 

7.5.2.1. MEDATLAS format 

 Time series 

o YEAR, MNTH, DAYX, and TIME are 4 mandatory parameters for time series in 
MEDATLAS format. 
These 4 parameters are automatically added by NEMO, in the output MEDATLAS file, 
from data and time read in the files and described in the station tab, or computed 
from the start date and the sampling rate of the time series (test p5). 

 Trajectories 

o YEAR, MNTH, DAYX, and TIME are 4 mandatory parameters for trajectories in 
MEDATLAS format. 
These 4 parameters are automatically added by NEMO, in the output MEDATLAS file, 
from data and time read in the files and described in the station tab, or computed 
from the start date and the sampling rate of the data (test p5). 
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o LATX (latitude) and LONX (longitude) are mandatory parameters for trajectories in 
MEDATLAS format. 
These 2 parameters are automatically added by NEMO, in the output MEDATLAS file, 
from the latitude and longitude read in the files and described in the station tab (test 
p8). 

o If bottom depth is read in the files and described in the station tab, the parameter 
BATH (bathymetric depth) is added automatically in the output MEDATLAS file. (test 
p4) 

7.5.2.2. ODV format 

 Time series 

o Depth is the mandatory vertical reference for time series at ODV format for 
SeaDataNet. 
If depth is not in the parameter table, depth is automatically added by NEMO, as a 
constant value equal to the sensor depth described in the station tab. 

o Time is automatically added by NEMO, in the output ODV file, from data and time 
read in the files and described in the station tab, or computed from the start date 
and the sampling rate of the time series. The format is time ISO8601  or chronological 
Julian date depending on the default time format chosen in NEMO settings. 

 Trajectories 
o If depth is not in the parameter table, and if the sensor depth is described in the 

station tab, then depth is automatically added by NEMO, as a constant value equal 
to this sensor depth. 

7.5.2.3. netCDF format 

 Trajectories 
o If depth is not in the parameter table, and if the sensor depth is described in the station 

tab, then depth is automatically added by NEMO, as a constant value equal to this 
sensor’s depth. 

7.5.3. Automatic insertion of SeaDataNet References 

This part is very important to keep track of the metadata and to allow links between SeaDataNet 
catalogues (linked data). For example, if the CSR of the collecting cruise is inserted in the data file as a 
sdn_reference, it will be possible to access the data directly from the CSR catalogue. 

Several sdn_reference are inserted in the file, depending on the metadata provided : 

 CDI references are automatically written in the output file. 

<sdn_reference  

xlink:href="https://cdi.seadatanet.org/report/edmo/10/cruiseRef_00001_H09" 
xlink:role="isDescribedBy" xlink:type="SDN:L23::CDI" sdn:scope="10:cruiseRef_00001_H09"/> 

 

 If the local CSR Id is set in the Cruise tab, CSR references are automatically written in the 
output file: 
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<sdn_reference xlink:href=" https://csr.seadatanet.org/report/edmo/486/localCSR/xml" 
xlink:role="isObservedBy" xlink:type="SDN:L23::CSR"/> 

 If the central CSR Id is set in the Cruise tab, CSR references are automatically written in the 
output file: 

<sdn_reference xlink:href=" https://csr.seadatanet.org/report/edmo/Central_CSR_reference/xml 
xlink:role="isObservedBy" xlink:type="SDN:L23::CSR"/> 

 If SHIP is set in the Cruise tab, SHIP references are automatically written in the output file 

<sdn_reference xlink:href="https:/www.seadatanet.org/urnurl/SDN:C17::35AY" 
xlink:role="isObservedBy" xlink:type="SDN:L23::NVS2CON"/> 

 If EDMERP codes are given in the Cruise tab, EDMERP references are automatically 
written in the output file 

<sdn_reference xlink:href="https://edmerp.seadatanet.org/report/12297" xlink:role="isObservedBy" 
xlink:type="SDN:L23::EDMERP"/> 

7.5.4. CDI summary file for MIKADO 

If “Generate SeaDataNet CDI summary” is selected in NEMO settings, NEMO generates a CDI summary 
CSV (Comma separated value) file to be used by MIKADO [3]. 

7.5.4.1. Description of the CDI summary file 

This CSV file contains all the necessary information for the generation of a SeaDataNet XML CDI file. 
The content of the CSV summary file for CDI is described in the following table:  
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Name 

(MIKADO var) 

Content Comment 

LOCAL_CDI_ID CDI ID in the data 
centre generating the 
CDI 

[Cruise reference]_[Station number]_[Data_type] 

Example: FI352002200040_00005_H10 

Or  

[data set reference]_[Station number]_[Data type] 

Example: XBT_2002_00005_H13 :  

EDMO AUTHOR 

(var01) 

EDMO ID of the data 
centre responsible for 
the CDI 

Input in NEMO settings 

AREA_TYPE 

(var02) 

Type of measurement  SeaDataNet Geospatial Feature Types (SeaDataNet 
common vocabulary, List L02) 

Set to ‘Point’ If vertical profiles and time series and to 
‘Curve’ if trajectories 

DATASET_NAME 

(var04) 

Name of the dataset Set to ‘Not Specified’, if cruise, set to Cruise Name, if 
dataset reference exists set to dataset reference 

DATASET_ID 

(var05) 

Dataset_ID Set to ‘Not Specified’, if cruise set to Cruise reference, if 
dataset reference exists set to dataset reference 

DATASET_REV_DATE 

(var06) 

Date of last revision of 
the dataset 

Date of the day in ISO format YYYY-MM-DDTHH24:MI:SS  

EDMO_ORIGINATOR 

(var07) 

EDMO_ID of  the 
dataset originator 

Input in NEMO settings 

DATASET_ABS 

(var08) 

Abstract describing the 
dataset 

Set to the “Cruise comment” content from NEMO Cruise 
tab (if empty Set to ‘Not specified’ ) or  to the   

–CruiseComment argument in batch mode 

EDMO_CUSTODIAN 

(var09) 

EDMO code of the 
organisation managing 
the dataset 

Input in NEMO settings 

P02_CODE 

(var10) 

Measured parameters BODC Parameter Discovery Vocabulary (SeaDataNet 
common vocabulary, List P02). 

The mapping between MEDATLAS codes input with 
NEMO and P02 is done automatically. 

L05_CODE 

(var11) 

L05 code for the sensor A  récupérer en faisant un mapping à partir du code C77 
(data type) de l’onglet station 

PLATFORM_TYPE 

(var12) 

Platform class SeaDataNet Platform Classes (SeaDataNet common 
vocabulary, List L06).  

To be input by the user. 

EDMERP_CODE 

(var13) 

Code of the associated 
project 

Set to the values of the field project of the Cruise Tab, if 
there is only one EDMERP_CODE. 

If several EDMERP_CODE see §7.5.4.2 

DATASET_ACCESS 

(var14) 

Dataset access 
restrictions 

SeaDataNet Data Access Restriction Policies (SeaDataNet 
common vocabulary, list L08).   

To be input by the user. 

CRUISE_NAME 

(var15) 

Cruise name If cruise: set to cruise name 

If collection of files grouped by cruise: set to the name of 
the directory  

If collection of files not grouped by cruise =  set to ‘Not 
specified’ 
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CRUISE_ALT_NAME 

(var16) 

An alternative name 
for the cruise 

Set to Local CSR identifier or Central CSR reference 
(Cruise tab) 

CRUISE_START_DATE 

(var17) 

 Set to the Start date (cruise Tab), and if empty to the 
Date of the first station (format YYY-MM-DD) 

STATION_NAME 

(var18) 

Station name Set to station number 

STATION_DATE 

(var20) 

Date of the station 

YYYY-MM-DD 

 

SAMPLING_RATE 

(var22) 

Sampling rate Set to the value of the sampling rate field (Station Tab) if 
given or calculated from the TIME values of the input file.  

SAMPLING_RATE_UNIT 

(var23) 

Unit of the sampling 
rate 

Set to the P06 code for Seconds = UTBB 

STATION_LONGITUDE 
or WEST_LONGITUDE 

(var24) 

Longitude of the 
station  

Decimal degrees 

If Vertical profile or time series the field name is 
STATION_LONGITUDE and is the station longitude. 

If Trajectories the field name is WEST_LONGITUDE and is 
the Westernmost Longitude of the trajectory 

EAST_LONGITUDE 

(var25) 

Easternmost Longitude 
of the trajectory 

Decimal degrees 

Only for trajectory, is the Easternmost Longitude of the 
trajectory 

STATION_LATITUDE or 
SOUTH_LATITUDE 

(var26) 

Latitude of the station 

Decimal degrees 

If Vertical profile or time series the field name is 
STATION_LATITUDE and is the station latitude. 

If Trajectories the field name is SOUTH_LATITUDE and is 
the Southernmost Latitude of the trajectory 

NORTH_LATIITUDE 

(var27) 

Northernmost 
Longitude of the 
trajectory 

Decimal degrees 

Only for trajectory, is to the Northernmost Latitude of 
the trajectory 

STATION_START_DATE 
(var28) 

Start date of the 
station 

YYYY-MM-DDTHH:mi:ss 

Data and time of the station 

STATION_END_DATE 
(var29) 

Start date of the 
station 

YYYY-MM-DDTHH:mi:ss 

If vertical profile: station start date + 1:00 hour 

If trajectories and time series date and time of the last 
measurement 

MIN_DEPTH 

(var30) 

Minimal depth of the 
measurements  

Metres 

Extraction from the measurements 

For time-series and trajectory = to MAX_DEPTH 

MAX_DEPTH 

(var31) 

Maximal depth of the 
measurements 

metres 

Extraction from the measurements 

For time-series and trajectory = to MIN_DEPTH 

BOTTOM_DEPTH 

(var35) 

Bottom depth 

metres 

Not available for trajectories 

EDMO_DISTRIBUTOR 

(var36) 

EDMO code of the 
organisation 
distributing the dataset 

Input in NEMO settings 

FORMAT 

(var37) 

Format Type of file In Nemo : 

If MedAtlas : MEDATALAS 

If ODV: ODV 

If netCDF: CFPOINT 

FORMAT VERSION 

(var38) 

Version of file format Input in NEMO settings 
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DATA_SIZE 

(var39) 

Size of the data file For profiles and time-series:  

If one file per station = Size of the file in Mbytes 

If one file per cruise: Size of the Cruise 
file/number of stations in Mbytes 

for trajectories: the size of the file in Mbytes 

DIST_WEBSITE 

(var40) 

Distribution website Must be set to « http://www.sdn-taskmanager.org/ »  

Input in NEMO settings 

DIST_METHODE 

(var43) 

Distribution method SeaDataNet data access mechanisms (SeaDataNet 
common vocabulary, List L07). 

Input in NEMO settings 

L22_CODE 

(var49) 

Instrument code Set to the L22 code of the Data Tab 

CENTRAL_CSR_REFERE
NCE  

(var81) 

Reference of the cruise 
in the CSR central 
catalogue 

Set to the Central CSR reference (cruise Tab) or if empty 
retrieved from the CSRCodeList.xml file (with the EDMO 
code of the organization creating the CSR metadata 
(NEMO Settings) and the LOCAL CSR Identifier (Cruise 
Tab). Left to empty if not found 

7.5.4.2. CDI_SUMMARY_EDMERP file 

When creating the CDI-SUMMARY, if several projects are attached to the Cruise, then a text file is 
created with the name CDI_SUMMARY+_EDMERP ; 

This text file contains the following information: in  columns, separated by tabs: 

 LOCAL_CDI_ID 

 EDMERP_CODE 

Example of content  for a file with 2 Stations and a cruise linked to 35 projects (EDMERP): 

LOCAL_CDI_ID EDMERP_CODE 
FI35201805100_00001_H10 12297 
FI35201805100_00001_H10 11760 
FI35201805100_00001_H10 11824 
FI35201805100_00001_H10 12222 
FI35201805100_00001_H10 11828 
FI35201805100_00002_H10 12297 
FI35201805100_00002_H10 11760 
FI35201805100_00002_H10 11824 
FI35201805100_00002_H10 12222 
FI35201805100_00002_H10 11828 

7.5.4.3. CDI_SUMMARY_CURVES file 

When NEMO converts a trajectory file, and the creation of a CDI_Summary is requested, the track of 
the trajectory is generated in a CDI_SUMMARY_CURVE.txt separate file, which will be used to fill in the 
var 60 (Curves-description), var 62 (Curves-name) and var 63 (Curves-coordinates) of MIKADO. 

This text file contains the following information in 4 columns, separated by tabs: 

 LOCAL_CDI_ID 

 CURVES-DESCRIPTION 
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 CURVES-NAME 

 CURVES-COORDINATES 
Example of the file content 

LOCAL_CDI_ID CURVES-DESCRIPTION CURVES-NAME CURVES-COORDINATES 
FABB_2008a_TS_00001_H71 CURVE 1 CURVE 1 -4.9231 48.2812 -4.9085 48.2784... 
FABB_2008a_TS_00001_H71 CURVE 2 CURVE 2 -4.7986 48.5539 -4.9758 48.5509... 
FABB_2008a_TS_00001_H71 CURVE 3 CURVE 3 -8.3748 43.3897 -9.0286 43.4300... 
FABB_2008a_TS_00001_H71 CURVE 4 CURVE 4 -11.5717 40.9605 -11.8378 40.5348... 
FABB_2008a_TS_00001_H71 CURVE 5 CURVE 5 -19.4222 33.0384 -20.0088 33.1444... 
FABB_2008a_TS_00001_H71 CURVE 6 CURVE 6 -25.1112 23.3122 -25.0293 22.9225… 
FABB_2008a_TS_00001_H71 CURVE 7 CURVE 7 -17.4239 14.6727 -17.5027 14.6443… 
FABB_2008a_TS_00001_H71 CURVE 8 CURVE 8 -28.6215 38.5330 -29.1291 38.3438… 
FABB_2008a_TS_00001_H71 CURVE 9 CURVE 9 -6.1950 47.4430 -6.7459 47.5800… 
 

At the same time, a .gpx file is created to facilitate the display of a route in GPS software to check that 
there are no mistakes and wrong locations of the track. This file can easily be opened in online tools 
(like for example http://www.gpsvisualizer.com/). 

Note: to recover the Longitudes, Latitudes of the trajectories, an algorithm has been implemented to 
limit the number of listed values to the maximum (only the changes of direction are kept), not to cross 
the terrestrial parts, not to join 2 points if there is an interruption in the measurement, and not to keep 
duplicate points 

A new CURVE is created in case of passage through the anti-meridian, and in case of interruption of 
the measurement for a sufficient time for two consecutive points to be distant from each other. 

 

7.5.4.4. USE of the CDI-SUMMARY files by MIKADO 

To use the CDI_SUMMARY, CDI_SUMMURY_EDMERP, and CDI_SUMMARY_CURVES file(s) with 
MIKADO to generate an export of XML CDI records, refer to Mikado’s user manual [3]. 

7.5.5. Coupling table for SeaDataNet Replication Manager 

If “Generate mapping for SeaDataNet Replication Manager” is clicked in NEMO settings, for all 
conversions of data files NEMO will insert records in the coupling table which exists in the local 
database of NEMO. NEMO inserts one record for LOCAL_CDI_ID. 

The coupling table contains the following information: 

 LOCAl_CDI_ID,  

 Modus = 1 (for 1 station per file), 3 (for multi-station files) 

 Format (which is ODV or MEDATLAS)  

 File name as described in paragraph 7.5.1.  

 Date of creation 

LOCAL_CDI_DI + format is the unique index of the coupling table. 

This coupling table is used to create a coupling file used by SeaDataNet Replication Manager to make 
the mapping between a LOCAL_CDI_ID (one profile, one time-series, or one trajectory) and the name 
of the file containing this LOCAl_CDI_ID. 
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7.6. NEMO models 
The “Model” menu of NEMO allows one to save a model or to open an existing model: 

 

7.6.1. Save a model 

NEMO can save the model to let the user reuse it for a similar dataset. A full description of a dataset 
isn’t mandatory. 

By default, the model is saved as an XML file, in the default ‘models directory’ field in NEMO settings.  

The extension of the model file is “.xml”. 

7.6.2. Open an existing model 

A user can open an existing model to apply it with or without modification to a new dataset. 

The user must first enter the type of data to process (Cruise or collection), then select the file or the 
directory to be processed before opening the model. 

Opening a model before having selected input file(s) or directory results in an error message. 

If the model is not fully validated an information message is displayed. 

7.7. Coupling table management 
The “Coupling Table” menu of NEMO allows for managing the content of the mapping table defined in 
paragraph 7.5.5. 
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7.7.1. Edit the coupling table 

This function allows editing the content of the mapping table and to manage it. 

 

User can: 

 Search specific rows in the mapping table using the filter 

 Sort the mapping table by clicking the column title 

 Delete rows in the mapping table by selecting the row(s) and then clicking on the “Delete” 
button. The definitive delete is only done after clicking on Save. 

 Insert rows manually in the mapping table by typing the LOCAL_CDI_ID, Modus, Format, and 
Filename in the empty text inputs, then by clicking on New. 

 Edit a row by clicking it, then click in one of the editable columns (Modus, Filename, Date) to 
change it 

 Refresh the content of the table from the database. Refresh is canceling all changes not 
previously saved. 

 Quit without saving by clicking on Cancel. 

7.7.2. Export the coupling table 

This export function generates a coupling file that will be used by SeaDataNet Replication Manager for 
retrieving stations in the files. The default name for this coupling file is “coupling.txt”, but it can be 
changed in NEMO settings. 

The coupling file used by SeaDataNet Replication Manager is unique and called “coupling.txt”. This file 
must not contain duplicates (the coupling file ID is LOCAl_CDI_ID + format). It’s up to the NEMO user 
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to create only one file called “coupling.txt” for SeaDataNet purposes by using the coupling table 
facilities. 

The format of this coupling file is the following: 

Local_cdi_ID;Modus;Format;File_name 

7.7.3. Import a coupling file 

The import function allows importing a coupling file, in the same format as previously described 
(paragraph 7.7.2), into the coupling table. 

This can be useful if a user prefers to modify the coupling table using a text editor, he can successively:  

 Export the coupling table from NEMO,  

 Delete the coupling table in NEMO 

 Modify the coupling file in a text editor 

 Import the coupling file in NEMO 

 Export the new coupling table for SeaDataNet usage 

7.8. NEMO in batch mode 
NEMO can be run in batch mode if models have been previously defined. 

To launch a conversion, use the command nemo_batch with several arguments: 

-i: with the path and name of the input file or directory (mandatory) 

-o: with the path and name of the output file or directory (mandatory) 

-m: with the path and name of the model (mandatory) 

-c: with the format odv, medatlas, netcdf (mandatory) 

-cdiSummary: with the path and name of the CDI summary (optional) 

-couplingTableUpdate: (optional) to ask for an update of the NEMO coupling table, if not 
present the table will not be updated. 

-couplingTablePrefix: with the prefix to use in the coupling table (available if –
couplingTableUpdate is selected) 

-mono: one station per file 

-multi: one file with all the stations 

-datasetRef: Sets the first part of the filename and the first part of the LOCAL_CDI_ID. Cannot 
be used when processing a collection. 

-cruiseName: sets the cruise name. Overrides the model value. 

-cruiseComment. Overrides the model value and input the value in the DATASET_ABS field of 
the CDI_summary file for MIKADO 

-shipCode: sets the ship code, and gets the ship name from the C17 list. Overrides the model 
value. 

-localCsrIdentifier: sets the Local CSR Identifier. Checks the identifier validity. Overrides the 
model value. 
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-bshCsrReference: sets the central CSR Reference. Checks the identifier validity. Overrides the 
model value. 

Note that -localCsrIdentifier and –bshCsrReference centralCsrReference are mutually exclusive. 

 

To launch an update of external resources (BODC vocabularies, CSR list, EDMO codes, Surveys list), the 
command is nemo_batch with only one argument: 

-updateVocabs: update external resources  

7.8.1. Windows environment 

.bat file examples: 

Copy the text in the boxes in a file named with .bat extension.  Do not forget to adapt the text to your data and 
the conversion type you want. 

example1: launch one Nemo batch command 

“nemo_batch” -m  “C:\testNEMO\models\ mona_ctd_1221_P01.xml” -i “C:\testNEMO\mona_ctd\trav1” 

-o “C:\testNEMO\mona_ctd\outputODV” -c odv –multi –cdiSummary “C:\testNEMO\mona_ctd\cdi.txt” 

 -couplingTableUpdate -couplingTablePrefix “C:\testNEMO\mona_ctd” 

example 2: launch Nemo batch on all files in a directory 

@echo off 

REM============================================================================= 

REM little batch script to call NEMO on several files in the same directory 

REM this script must be put in the Nemo installation directory (usually C:\Program Files\NEMO) 

REM this file can be used to run Nemo in batch mode on several files using the same model 

REM============================================================================== 

 

REM set the input directory path in the line below 

setinputDir=C:\myData\115518\input\ 

setoutputDir=C:\myData\output\ 

setmodelFile=C:\myData\myModel.xml 

 

REM here we loop on all files in the inputDir, except files beginning with "PF_", because these are files created by Nemo 

for /f %%a IN ('dir  /b "%inputDir%"*.* ^| find /V "PF_"') do ( 

REM the line below just displays the current input file name in the console 

echo processing file: %%a 

REM the line below calls NEMO in batch mode on the current file ("%%a", and creates the output file called as the input, 
but ending with ".odv" 

REM CHANGE HERE the conversion format if needed and the datasetRef 

call  nemo_batch -i "%inputDir%%%a" -m "%modelFile%" -o "%outputDir%%%a.odv" -c ODV  -multi -datasetRef 
myDatasetRef 

) 
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7.8.2. Linux environment 

On Linux, launch nemo_batch with the following additional arguments: 

-nosplash (mandatory) 

-batch (mandatory) 

 

Example of one command line which can be in a shell script file: 

#!/bin/sh 

./nemo_batch -nosplash -batch -m ./testNEMO/models/mona_ctd.xml -i ./testNEMO/mona_ctd/trav1 

-o ./testNEMO/mona_ctd/outputODV -c odv 

7.8.3. Log file 

While the batch is running, a log file is created in the NEMO installation directory 
(NEMO_installation_directory\Logs\nemoBatch.log file). 

The program appends messages in the log file (one log file per day). 

Example of a log file with an error : 

2010-05-04 15:43:27,337 [main] INFO  nemoBatch / Batch mode starting. Arguments : 

2010-05-04 15:43:27,337 [main] INFO  nemoBatch / -batch -m 
C:\Michele\testNEMO1.2.20\modeles\mona_ctd_1221_P01.xml -i 
C:\Michelex\testNEMO1.2.20\mona_ctd\trav1 -o 
C:\Michele\testNEMO1.2.20\mona_ctd\outputODV_batch_mono -c odv 

2010-05-04 15:43:27,368 [main] ERROR nemoBatch / Input file not found 

2010-05-04 15:43:27,368 [main] INFO  nemoBatch / Batch mode ended with errors. 

Example of log message with no error : 

2010-05-04 15:38:11,492 [main] INFO  nemoBatch / Batch mode starting. Arguments : 

2010-05-04 15:38:11,492 [main] INFO  nemoBatch / -batch -m 
C:\Michele\testNEMO1.2.20\modeles\mona_ctd_1221_P01.xml -i 
C:\Michele\testNEMO1.2.20\mona_ctd\trav1 -o 
C:\Michele\testNEMO1.2.20\mona_ctd\outputODV_batch_mono -c odv 

2010-05-04 15:38:23,007 [main] INFO  nemoBatch / Batch mode successfully ended. 

7.8.4. The BatchBuilder tool 

Since NEMO 2.0 a new tool has been developed to help the user to write Batch procedures.  

This tool allows the creation of batch files for the conversion  

 of one file and one NEMO model 

 of a set of files that can need to be converted to the same output format but with different 
batch arguments (available in a mapping file or the NEMO model file). 

To open the BatchBuilder tool, open the “Options” menu of NEMO and choose Command Batch Builder 
as below: 
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This will open the windows described hereafter. 

7.8.4.1. Creation of a batch command for one file 

The window for the creation of a batch command for the conversion of one file is shown in Figure 30  

 

Figure 30 - Creation of a batch command for the conversion of one file 

Pay attention to having coherency between the model file and the conversion type (i.e. if the model is 
for the creation of an ODV file, be sure to have selected ODV as the output format) 

If a file and a model are already uploaded in NEMO, the Batch Builder will be prefilled with the values 
of the model, for example in Figure 31. 
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Figure 31 - Batch builder window for the conversion of one file, prefilled with the information of NEMO 

The command line at the bottom of the window is automatically updated with the values input in the 
different fields. 

At the bottom of the screen, the 4 buttons can be used for: 

 Reset: Empty all the fields on the screen 

 Save: Save the batch command in a batch file (.bat for Windows and .sh for Linux), this 
command can then be used in batch mode. 

 Run: Run the batch command, the log of the run is written in the nemobatch.log file in the 
NEMO installation directory. Note that the Run button is active only when all the mandatory 
fields of the batch are fulfilled (input file, model file, Output file, and conversion Type). 

 Cancel: Quit the Batch builder window. 

 

mailto:sdn-userdesk@seadatanet.org
http://www.seadatanet.org/


 

sdn-userdesk@seadatanet.org – www.seadatanet.org 

SeaDataNet - The pan-European infrastructure for marine and ocean data management 

 89 

7.8.4.2. Creation of a batch command for one directory 

The creation of a batch file for the conversion of a set of files relies on a Mapping file that has to be 
created ahead of using the Batch Builder. In one mapping file, all the models used should be for the 
same output format (i.e.: one mapping file with all models for conversion to ODV, and another 
mapping file with all models for conversion to NetCDF) 

The mapping file is a CSV file, with ‘;’ used as the separator, with all the necessary content of the batch 
arguments for each file. 

It is composed of 10 columns corresponding to the batch arguments which can change from one file 
to another (the mandatory arguments are in bold characters): 

 fileNameIn: name of the input file, without the path 

 modelName:: name of the model file, without the path 

 fileNameOut:: name of the output file, without the path 

 datasetRef: Dataset reference 

 cruiseName: cruise name 

 cruiseComment: Cruise comment 

 localCsrIdentifier: Local reference of the CSR 

 bshReference: central reference of the CSR 

 cdiSummary: name of the CDI-SUMMARY file, without the path 

 shipCode: C17 code of the platform 

Example of a mapping file for the Batch Builder: 

fileNameIn;modelName;fileNameOut;datasetRef;cruiseName;cruiseComment;localCsrIdentifier;bshCsrReferenc
e;cdiSummary;shipCode 
FI352008090050.txt;gosud_model_odv_Fanindien2008.xml;output_GOSUD_FI352008090050.txt;FI3520080900
50;MADAGASCAR 2008 - LEG1;cruise off Toamasina;8090050;;summaryFI352008090050.txt;35B5 

FI352008090070.txt;gosud_model_odv_Fanindien2008.xml;output_GOSUD_FI352008090070.txt;FI3520080900
70;FANINDIEN 2008;TSG FANINDIEN;8090070;;summaryFI352008090070.txt;35B5 

FI3520080900780.txt;gosud_model_odv_Fanindien2008.xml;outputFI352008090080.txt;FI352008090080;MAD
AGASCAR 2008 - LEG2;cruise off Toamasina;8090080;;summaryFI352008090080.txt;35B5 

 

The windows for the creation of a batch command for the conversion of a set of files is shown in Figure 
32. 
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Figure 32 - Creation of a batch command for the conversion of a set of files 

The following files need to be input (the mandatory fields are in bold characters): 

 Input Directory: path to the directory of the input files to be converted with NEMO 

 Model Directory: path to the directory of the models used for the conversion with NEMO 

 Output Directory: path to the directory of the output files of NEMO in SDN format 

 CSV mapping file: path and name of the CSV file to be used for the conversion 

 Conversion Type: Check the format in which the input files will be converted (must be coherent 
with the model declared in the mapping file) 

 Conversion Option: Check Mono for conversion to mono-station files or Multi for conversion 
to multi-station files.  

 Sort data: to be checked if the input data are not sorted by increasing reference parameter 

 cdiSummary: Path to a directory for the CDI-Summary files 
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 coupling Table Update: to be checked if coupling table records have to be created 

 couplingTablePrefix: with the prefix to use in the coupling table (available if –
couplingTableUpdate is selected) (see §7.5.1 for explanations) 

The command lines are written at the bottom of the screen as the information is being entered. 

At the bottom of the screen, the 3 buttons can be used for: 

 Reset: Empty all the fields on the screen 

 Save: Save the batch command in a batch file (.bat for Windows and .sh for Linux), this 
command can then be used in batch mode. 

 Cancel: Quit the Batch builder window. 
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9. Appendix 1 – Proxy connection to the internet 
To get the proxy address and port please do as follow: 

9.1. Firefox 
Go into the following menus: 

Tools> Options> General > Proxy > Parameters 

If you have got a Proxy configuration, the address and port to add in the nemo.ini file are in the HTTP 
Proxy and Port fields of the following window: 

 

9.2. Internet Explorer 
Go into the following menus: 

Tools, Internet Options, Connection, Local Area Network (LAN) settings 

If a Proxy configuration is set, the address and port to add in the nemo.ini file are in the Proxy server 
Address and Port fields of the following window: 
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10. Appendix 2 – Writing regular expressions 
1/ 

use "x" to represent the character "x" 
use "." to represent any character including white space, digital number... 

2/ 

use one of the following symbols to indicate the occurrence of this character: 
use "?"  to indicate once or not at all (ex. "a?" for search "a" once or not at all) 
use "*"  to indicate zero or more times (ex. "b*" for search "b" zero or more times) 
use "+"  to indicate one or more times (ex. "f+" for search "f" one or more times) 
 
More about pattern possibilities: 
http://download.oracle.com/javase/1.4.2/docs/api/java/util/regex/Pattern.html 
 
Note:  
===== 
Nemo automatically adds ".*" at the end of the pattern, while we are searching for a string at the 
beginning of a line. 
 
Example: 
========= 
a world beginning with "toto", ending with "zz", with one or several unknown characters in the middle 
(ex. "totoazertyzz") 
use pattern="toto.*zz" 
where "." represents any character and "*" indicates that this "any character" can occur zero or more 
times. 
 
This pattern will match with the following words: 
totoabcdefzzxy 
totoabcdefzz 
toto1234zz 
totoab56zz 
totoab 34 zz 
totozz 
totozz 
 
This pattern will NOT match with the following words: 
toabcdzz ("toto" not found) 
totoabcd ("zz" not found) 
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